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Why LapLink?

Lnetwork
apLink gives you the freedom to leave the office without giving up access to your office computer and
resources. Whether you’re traveling on business or working from home, you can still read your
e-mail, share the latest files with coworkers, access network programs and databases, browse the
Internet over a high-speed connection, and collaborate with colleagues. Things you once could do only in
the office you can now do remotely.

Suppose you work at home
Instead of joining the morning rush-hour traffic, you sit down
at your home computer, connect to your office, and begin
your workday as usual, by tackling your e-mail.
While finishing your orange juice, you read your messages,
write new ones, send replies—in other words, you operate
much as you would in the office. You’re using LapLink. In
particular, you’re using Remote Control, one of the LapLink
services, to operate your office computer from home.
On your home monitor you see what you would have seen
had you commuted to work, and you operate your e-mail
program as you would have from the office. You can even
use your home printer for those messages you’ll review later.
Forget to get the latest copy of a file before leaving the
office? Move to File Transfer, another LapLink service, and
drag the file from the folder on the office network to its location on your hard drive at home. Since you’re updating a file
already on your home computer, the file is transferred
almost before you know it. (In fact, LapLink merely updates
the file, transferring only the parts that have changed.)
Returning to Remote Control, you start a network application and access the company’s huge product database.
Just as you thought, customers ordered more blue widgets
last month than during the previous two months combined!
More grist for the quarterly report you’re working on.
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While you’re still connected, you check out a rumor. Is the
competition really selling their widgets at cutthroat prices?
Connecting over the dedicated Internet line in the office, you
visit the competition’s Web site. Whew, no price war after all!
A final check of your e-mail confirms your suspicions. It’s off
to Chicago tomorrow for a two-day business trip.

Suppose you’re on a business trip
At the airport, you arrive early enough to check your latest
e-mail and send a message you’ve forgotten in your rush to
pack. Using your PDA, you log on to the LapLink Everywhere Service Center and display the messages waiting for
you back in the office. By subscribing to the LapLink Everywhere service, you’re able to access your office computer
from your PDA or any other device capable of surfing the
Internet.
Settling into your hotel room hours later, you take your eyes
off the view long enough to discover a dedicated digital
phone line. All the better to connect your laptop to your
office computer, first by dialing the local number for your
Internet service provider and then by opening a LapLink
connection over the Internet.
It’s been a busy day. You need to catch up with your
coworkers and exchange the latest files with them. You rush
through your e-mail, finishing in time to connect to a
coworker’s computer. Her e-mail sounded desperate: if

. . . Why LapLink?
you’re free before 7 o’clock this evening, could you help with
the cover art for the annual report?
Now you’re looking at her monitor and talking to her at the
same time, using another LapLink service, Voice Chat. After
some discussion and trying this and that, the two of you
agree: make the logo larger and reverse the colors. She’ll
have a finished draft waiting for you on the network in an
hour.

In an hour, however, you expect to be at your favorite Chicago restaurant, choosing from the dessert menu. On your
way out the door, you schedule LapLink to reopen the connection with the office and synchronize folders on your laptop with folders on the office network.
By the time you return to your hotel room, LapLink will have
exchanged the quarterly report you finished on the red-eye
flight this morning for the reports that await your review on
the office network. And you’ll get the latest draft of the cover
art as well. Now to find the time to review all of this.

7

Staying in touch with the office

P
hone lines, modems, and LapLink: with these basics you can connect to the office from home or
elsewhere. To these basics you can add a network, a network server, and the Internet. You determine
how to connect by considering your office setup and what you want to accomplish when you are
connected.
You can connect to the office if your home computer or your
laptop has at least a modem and a phone line to connect to.
Depending on the availability of a network and the Internet
in your office, you can then make any or all of these kinds of
connections:
• To your office computer directly
• To your office computer or another office computer
through the office network
• To your office computer through the Internet

Connecting directly to your office computer
If your office computer is equipped with a modem, you can
connect to the computer directly, using Connect over
Modem.
Turn on the modem and leave LapLink running when you
leave the office. Then connect through the modem and run
programs and transfer files as you would normally.
If your computer is attached to a network, you can read your
e-mail and access the customary network resources,
though you cannot connect to other computers on the network.

Connecting to the office network
If your office has a network, you can connect to the network
and then to any computer running LapLink on the network,
8

including your own. In fact, you can access any network
resources normally available to you from the office. If you
browse the Internet from your desk at work, for example,
you can browse it from afar, too.
To connect to the office network, simply dial in to a dedicated network dial-up server using Dial-up Networking.

Connecting over the Internet
Many workstations have direct Internet access over dedicated, high-speed connections. If your office computer is
one of these—and you have Internet access from your
home computer or your laptop—you can connect to your
office computer in either of two ways:
• By setting up a LapLink Everywhere account for your
office computer and connecting through the LapLink
Everywhere server1
• By publishing the computer’s address through an ILS
(Internet locator service) and specifying that address
when you connect
Connecting by either means is like connecting to your office
computer by modem, with these advantages:
• The office computer does not require a modem.
1 LapLink Everywhere is especially useful when you connect to or from a computer behind a firewall. No special
firewall configuration is required.

. . . Staying in touch with the office
• If you make a local call to connect to the Internet while
you’re away from the office, you can save money on
your long-distance connections to the office.

other device that can surf the Internet. You can open a connection from almost any browser, even in libraries and Internet cafés.

• If you connect to the Internet over a high-speed line
while you’re away from the office, you can improve the
speed of your connection to the office.

Working within a Web browser on your Internet device, you
can perform some of the same operations you perform
within LapLink:

Connecting from a Web browser

• Read and send e-mail messages, adding attachments
as you wish

There may be times when you want a file or an e-mail message from your office computer but setting up your laptop
and running LapLink is not convenient or feasible. For such
situations, you can leave the LapLink Everywhere program
running on your desktop and connect from a PDA or any

• Upload and download files to and from your desktop
• Control your desktop remotely
• Access SQL databases on servers connected to the
desktop

9

Connecting from the office

W
ith greater resources at hand, you can make faster connections—and connect in more ways—while
working in the office. Connect over a corporate network, for example, for the fastest file transfers. Use a
LapLink cable to synchronize your desktop and laptop before and after you travel. And take advantage of
your organization’s direct connection to the Internet for cheap connections to distant locations.

Connect to other computers on your network
If your office is equipped with a local network (LAN), you
can connect directly to any other network computer running
LapLink using Connect over LAN (Network). Because
LapLink connections over networks are fast, they are ideal
for sending large amounts of data in a short time.
Suppose it’s your job to distribute files to several computers
every Tuesday. To automate the operation, create an
Xchange Agent file by showing LapLink which files to copy
and where to copy them. When Tuesday arrives, run the
Xchange Agent yourself or schedule it to run unattended, at
a time when the computers are usually idle. LapLink automatically connects to the computers, transfers files to the
designated folders, and disconnects, all without assistance.
It may also be your job to maintain those computers. Without leaving your desk, you can use Remote Control to troubleshoot problems on other computers, chatting with their
users, if necessary.

laptop before you leave; update files on your desktop when
you return.
To update files on either computer, attach a LapLink cable
and run LapLink on both computers. A connection opens
automatically.
You could then locate the most recent files, whether on the
laptop or the desktop, and copy them to the other computer.
Instead, you create an Xchange Agent to perform the operation automatically. You also set up LapLink to run the agent
whenever you start LapLink.
In the future, simply attach the cable and run LapLink on
both computers. Your files will be updated automatically.

Connect to distant computers over the Internet

Connect your laptop to your desktop

Does your office have a direct line to the Internet? If so, go
online and use Connect over LapLink Everywhere or Connect over ILS to locate other LapLink computers on the
Internet and open connections. By combining LapLink and
the Internet, you can connect to computers anywhere in the
world.

If you take your laptop—and your work—with you when you
leave the office, you know the routine: update files on your

Before you can use Connect over LapLink Everywhere, any
computers you want to connect to must have LapLink
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. . . Connecting from the office
Everywhere accounts. You can then connect to these computers through the LapLink Everywhere server.
Before you use Connect over ILS, other LapLink users must
set up LapLink on their computers so that their e-mail
addresses, or other unique identifiers, are “published”
through an ILS (Internet locator service) as their Internet
addresses. They then notify you of their new addresses.1

Once you go online and run LapLink, merely supply a computer’s Internet address to locate the computer and open a
connection.
1 Some computers have IP addresses that do not change. If
you connect to one of these computers, use Dial-Up Networking and supply that computer’s IP address.
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How can I connect to other computers?

D
etermine how to connect to another computer from the resources available to the two computers. For
example, are both logged on to the same office network? Then connect over the network. Use the tables
in this section to help decide how to connect. No matter which kind of connection you choose, you can
always use File Transfer, Remote Control, and the other LapLink services.

LapLink provides several ways to connect to
other computers.
Which method you use
depends on the
resources available to
the computers.

Connecting over the Internet
Can you connect to the Internet on
both computers?

Then connect over the Internet this way:

Yes

You have a choice:
• Subscribe to the LapLink Everywhere service and then use Connect over LapLink
Everywhere (Internet). If either computer is behind a firewall, this is the easiest Internet
connection. See page 22.
• Connect to the Internet as usual and then use Connect over ILS in LapLink. This connection uses an Internet locator service. See page 24.

No, but the office has a direct connection to the Internet
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Use Connect over Dial-Up Networking to dial in to a network server and connect over
the office Internet connection.

. . . How can I connect to other computers?
Connecting over modems, networks, cables, or
wireless devices
What resources are
available for connections
on the local
computer?

on the remote
computer?

modem

modem

modem

modem and network

modem

network with a
dial-up server

network

network

Then connect to another LapLink computer this way:

For details
see

Use Connect over Modem and dial in to the modem on the remote computer.
Modem connections are available in all versions of Windows.

page 16

Use Connect over Modem to connect directly to the remote computer and
access all of the network resources available to that computer.

page 16

Use Connect over Dial-Up Networking to dial in to the dial-up server and connect to any LapLink computer on the network.

page 18

Use Connect over LAN (Network).
Network connections are available in all versions of Windows.

page 30

page 34

page 36

parallel, serial, or
USB port

parallel, serial, or
USB port

Attach a LapLink parallel, serial, or USB cable to each computer. The connection
opens automatically.
Serial connections are available in all versions of Windows. Parallel connections
are available in Windows 95/98 and Windows Me. USB connections are available in Windows 98, Windows 2000, Windows ME, and Windows XP.

wireless device

wireless device

The connection opens automatically as soon as the devices come within range
of each other.
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Connecting directly by modem

U

sing modems and a phone line, you can connect to another computer or to an office network. For a
direct, LapLink to LapLink connection, dial a modem on another computer using Connect over Modem.
For a connection to an office network—and then to any LapLink computer on the network—use Dial-Up
Networking to dial a dedicated dial-up server (RAS).

Use Connect over Modem
to dial a modem on
another computer and
open a LapLink connection
to that computer.
Entries you have created
for modem connections in
Address Book appear in
the connection list to make
connecting easier.

When you dial directly to another LapLink computer, you
have access to all the programs and files available to that
16

computer (including any network resources if the computer
is logged on to a network).

. . . Connecting directly by modem
Connecting through a network
Once on the network, you can connect to another LapLink
computer and use LapLink services just as you would in a
direct modem-to-modem connection. But there’s more.
When you dial in to a network, you can also:
• Connect to any LapLink computer on the network, not
just one. (You can even transfer files from one computer to another.)
• Access all the network resources available to you in the
office. If you normally browse the Internet over the network, for example, you can do the same thing from a
remote location, using the browser on your local computer.
• Enhance security by combining LapLink password protection with network security.
For a Dial-Up Networking connection, your office network
(either TCP/IP or IPX) must have a dial-up server. (If in
doubt about your network, ask the network administrator.)
Using Dial-Up Networking, you dial in to the network
through this server.
• The LapLink security setup of the computer you are
connecting to must be changed to allow incoming connections. See page 46.
• LapLink must be running on both computers.
• Modem ports must be enabled in LapLink on both computers.

Dialing from an Address Book entry
Before dialing a computer, it’s a good idea to create an
Address Book entry for that connection. Use the entry to
store the phone number, requests for services (such as File
Transfer and Remote Control), password, and other pertinent information.

When you use Connect over Modem, you see the Address
Book entries you created for modem connections. When
you use an entry to dial a connection, information stored in
the entry is passed on to the remote computer for you. For
details about using Address Book for modem connections,
see page 20.
To connect to another computer by modem:
1 Click the Connect Over button on the LinkBar, and then
click Modem.
2 In the Connections list, click the connection you want to
open.
The connections listed under Manual Dial are your
Address Book entries for modem connections. To create
a new entry, click Address Book.
3 In the Dialing Location list, click the location you’re dialing
from.
4 Under Services, check services you want to use.
5 Click the Dial button.

Dialing manually
To dial a connection that is not complicated by such considerations as calling cards, outside lines, and country codes,
you can type the phone number without creating an
Address Book entry beforehand. LapLink dials the number
exactly as you type it, regardless of how you have set up
Dialing Properties.
To dial manually:
1 Click the Connect Over button on the LinkBar, and then
click Modem.
2 Click Manual Dial.
3 In the Phone Number box, type the number to dial.
4 Click the Dial button.
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Dialing in to a network through a network server: Dial-Up Networking

U

se Dial-Up Networking to dial in to a dial-up server (RAS) and log on to a network from outside the
office. Then connect to other LapLink computers on the network and use network resources as if you
were still in the office.

Use Dial-Up Networking to
dial in to a dial-up server
and connect to a network.
Then open connections to
other LapLink computers
on the network.

Use Dial-Up Networking to access a network after you leave
the office. By dialing in to a dial-up server (RAS) on the network, you can connect to any computer running LapLink on
that network.
You can also connect to LapLink computers on the Internet
and browse the Internet using the Internet connection in the
office. In short, you can access the same network resources
you use in the office.
18

Before you use Dial-Up Networking
• Dial-Up Networking, a Windows feature, must be
installed on the computer you dial from. See Windows
help for instructions.
• Your network must have a dedicated dial-up server
(such as Novell NetWare Connect, Windows Remote
Access Server, or Shiva NetModem). The computer
you connect to must be connected to an IPX or TCP/IP

. . . Dialing in to a network through a network server: Dial-Up Networking
network. It must also be running LapLink, and its security setup must have been altered to allow incoming
LapLink connections. See page 46.

Setting up a Dial-Up Networking connection
Before using Dial-Up Networking, create a Dial-Up Networking connection to the network server by supplying the
number to dial.
To create a Dial-Up Networking connection:
1 Click the Connect Over button on the LinkBar and then
click Dial-Up Networking.
2 Click the New Connection button and follow the instructions
on your screen.

Connecting to a network computer using Dial-Up
Networking
To use Dial-Up Networking to connect to a network
computer:
1 Click the Connect Over button on the LinkBar and then
click Dial-Up Networking.
2 In the list of connections, click the connection to your network server.
3 Ensure that this box is checked: After Dialing, Connect to a
Computer on a Network.

4 Click the Dial button.
5 When prompted, type the user name and password1
required by the dial-up server.
6 In the Connect over LAN (Network) dialog box, click the
name of the computer you want to connect to.
If the computer is not listed and you are attempting to
connect over a TCP/IP network, click the TCP/IP
Addresses tab. Then do either of the following:
•In the Connections list, click the name of the computer
you want to connect to.2
•Under TCP/IP Name or Address, type the IP address of
the computer.3
7 Under Services, verify that the services you want to use are
checked.
8 Click OK.
1 For information about typing capital letters and lowercase
letters in passwords, see page 21.
2 The computers in the Connections list are those you have
placed in Address Book. For information about creating
Address Book entries for Dial-Up Networking connections,
see page 20.
3 For information about determining an IP address, see
page 31.
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Using Address Book for modem connections

M

aking entries in Address Book simplifies the process of opening the same direct modem connections
time after time. In your entries you store phone numbers, requests for services (such as File Transfer and
Remote Control), and passwords. When you use Connect over Modem, this information is passed on to
the remote computer for you. You can also set up entries for connections you make to network computers
after you dial in to a network using Dial-Up Networking.

For modem connections
you make again and again,
simplify the connecting
process by adding entries
to Address Book.
Then access the information you store in these
entries when you use Connect over Modem or DialUp Networking.

Address Book is a convenient way of storing all the information you need to connect to another computer using Connect over Modem.
Address Book works in tandem with Dialing Properties, the
Windows feature that lets you determine how your numbers
are dialed. Use Dialing Properties to charge a call to a calling card, for example, reach an outside line, or place longdistance and international calls. For more information about
Dialing Properties, see Windows help.
20

To create an Address Book entry for a Connect over
Modem connection:
1 Click the Address Book button on the LinkBar, and then
click the Add button.
2 In the Description box, type a brief description of the remote
computer for your own reference.
3 In the Computer Name box, type the LapLink name
assigned to the remote computer.

. . . Using Address Book for modem connections
4 In the Connection Type list, click Modem.
5 Under Phone Number, type the area code and phone number, and click the country code.
TIP If you want to have a phone number dialed exactly as
you type it in the Telephone Number box, clear this box:
Use Country Code and Area Code.
TIP Requests for services in Address Book are honored
only if the security setup of the remote computer permits.
6 Under Services, check the services you want to use.
TIP You can change your selections later, as part of the
connection process. You can also request new services
after you connect.
7 Under Host Locking on Connect, check the kind of locking
you want to take effect on the remote computer when you
connect for Remote Control.
You can lock a host (blank its screen or disable its mouse
or keyboard) only if it has been configured to allow locking.
8 Under Security Information to Send, type the log-in name
and the password you must provide in order to gain access
to the remote computer. Reenter the password to confirm.
When you finish the entry, you see Address Book and the
description of the new entry. If you want to create another
entry, click Add again and complete the entry. Otherwise,
click Close.

Using Address Book for dial-up connections to
network computers
For LapLink connections you make after dialing in to a network, set up Address Book entries to store requests for services and security information. This information is passed to
the network computer after you connect to a network using
Dial-Up Networking.
As the Connection Type, use Network: Available Now if the
computer normally appears in the list of available computers when you use Connect over LAN (Network) in the office.
Otherwise, use Network: TCP/IP Address and type the
computer’s IP address. To determine a computer’s IP
address, see page 31.

Entering passwords
LapLink Gold passwords are case-sensitive (i and I, for
example, are treated differently). For connections to other
computers running LapLink Gold, type passwords in capital
or lowercase letters exactly as they were typed on those
computers.
NOTE Passwords in LapLink Pro, LapLink Tech, or
LapLink 7.5 or earlier are not case-sensitive. In Address
Book entries for connections to any of these versions, type
passwords in ALL CAPITAL LETTERS. If you have old
Address Book entries for such connections, retype their
passwords in all capital letters.
NOTE Because of the change in case sensitivity, Address
Book entries created in an earlier LapLink version may no
longer let you connect to computers that have also been
upgraded. Have new passwords set up on those computers; then change your Address Book entries to match.
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Connecting over the Internet using LapLink Everywhere

Lbecause
apLink Everywhere1 offers the easiest and most flexible Internet connections. They are the easiest
they maintain security without the need to wrestle with firewalls. They are the most flexible
because you can connect not just in the traditional LapLink-to-Laplink way but from any device with which
you can browse the Internet, including cell phones, PDAs, and public access computers like those found
in libraries and Internet cafés.
You can use LapLink Everywhere connections for traditional LapLink-to-LapLink connections.
Or you can connect from any Internet
browser, without using LapLink at all.

LapLink Everywhere and LapLink Gold are two programs
that have been designed to work separately or together.
Unlike LapLink Gold, LapLink Everywhere needs to be
installed only on the host computer—the home or office

computer you want to connect to. It does not have to be
installed on the computer you connect from.
Once the LapLink Everywhere program is installed on the
host computer, you can connect to it in two ways:

1 LapLink Everywhere is a subscription service. Your purchase of LapLink Gold 11.5 entitles you to 30 days’ free use of the LapLink
Everywhere mobile access service. For more information about LapLink Everywhere fees and features go to www.LapLink.com.
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. . . Connecting over the Internet using LapLink Everywhere
• Open a LapLink connection from another computer running LapLink Gold. LapLink Gold must be running on
both computers, but LapLink Everywhere needs to be
installed and running only on the host.
• Open a LapLink Everywhere connection from an Internet browser. Simply leave LapLink Everywhere running
on the host computer. You do not have to run LapLink
at all.
For maximum flexibility, leave both LapLink Gold and
LapLink Everywhere running on the host computer. You can
then connect from another computer running LapLink Gold
and from any device that allows you to browse the Internet.
Only LapLink-to-LapLink connections offer the complete
range of LapLink features. When you use an Internet
browser, you can read e-mail, transfer files, and perform
remote control, but advanced features like automatic synchronization are not available.

Preparing to use LapLink Everywhere
As part of the installation of LapLink Gold you are asked
whether you want to set up your LapLink Everywhere
account and install LapLink Everywhere.
Simply create a unique user name and password. If you
install LapLink Everywhere on more than one computer, be
sure to use the same user name and password for each
one.
As with other kinds of connections, you must configure the
security setup of the host computer to allow incoming connections. See page 46.
If you intend to connect to the computer from an Internet
browser and use remote control (at additional cost), you
must also install LapLink Secure VNC or WinVNC on the
host computer.

If you intend to access a SQL database, a SQL database
server for which you have an ADO connection string. In
addition, the remote device must have Microsoft Data
Access Components (MDAC) 2.6 or later installed on it.

Connecting from another LapLink computer over
LapLink Everywhere
To connect over LapLink Everywhere to another computer running LapLink:
1 Click the Connect Over button on the Linkbar and then
click Connect over LapLink Everywhere (Internet).
2 Type the user name and password set up for your LapLink
Everywhere account.
3 Click OK.
4 When asked again for a user name and password, supply
whatever is required by the LapLink Gold security setup on
the host computer. (See page 46.)

Connecting from any Internet browser
You can connect to the host computer from almost any
device equipped to browse the Internet—from another PC or
a Mac to a PDA or an Internet telephone. The chief requirement is that the device must be set up to allow cookies.
To connect over LapLink Everywhere from an Internet
browser:
1 Log on to www.MyLapLink.com.
2 Type the user name and password set up for your LapLink
Everywhere account.
3 Click the Login button.
4 When asked again for a user name and password, supply
whatever is required by the LapLink Gold security setup on
the host computer. (See page 46.)
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Connecting over the Internet using an ILS

C

onnect to the Internet using an ILS (Internet locator service), and you can open connections to other
LapLink computers anywhere in the world, without spending a fortune. To make a computer easy to find
on the Internet, use the LapLink ILS to “publish” the computer’s Internet address. Other computers can
then supply this address to open connections using Connect over ILS.

Go online and use Connect over ILS to locate and
open connections to
LapLink computers anywhere on the Internet.
Make a connection by supplying the address published by a remote
computer through the
LapLink ILS.

When you connect to another LapLink computer on the
Internet, you can use Remote Control, File Transfer, and
any of the other LapLink services you would use when connected directly by modem—often at reduced cost. You can
connect over the Internet using LapLink Everywhere (see
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page 22). Or you can publish your computer’s address
through an ILS (Internet locator service) like the one hosted
by LapLink Software and then connect using Connect over
ILS. Simply supply the Internet address published through
the ILS.

. . . Connecting over the Internet using an ILS
Before you can connect using an ILS
• Both computers must be connected to the Internet.1
• The remote computer (the one you are connecting to)
must have its Internet address published through an
ILS (Internet locator service). See page 26.
• The security setup of the remote computer must have
been configured to allow incoming connections. See
page 46.
• The TCP/IP ports must be enabled in LapLink on both
computers. See page 137.
• LapLink must be running on both computers.2

Using Connect over ILS
To connect to another LapLink computer using an ILS:
1 Connect to the Internet as usual.

Otherwise, click Manual Connect. In the Internet Address
box type the remote computer’s Internet address (the
one the remote computer has published through an ILS.
4 Under Services, check the services you want to use.
5 Click OK.

Using Address Book for ILS connections
For LapLink connections you make using Connect over ILS,
you can set up Address Book entries to store Internet
addresses, requests for services, and security information.
All of this is passed on to the network computer when you
use Connect over ILS.
When you create an Address Book entry for the Internet, be
sure to specify Internet Address in the Connection Type
box.

2 On the Connect menu, click Connect over ILS.

Opening Internet connections using Connect over
LAN (Network)

3 If you have created an Address Book entry for the connection you want to open, click the connection in the Connections list.

Just as you use Connect over LAN (Network) for connections on a local TCP/IP network, so you can use it for connections on the Internet, a global web of TCP/IP networks.

1 If you are out of the office and without access to the Internet, dial back to the office network and use the office Internet connection. See page 30.
2 If you are out of the office and without access to a computer with LapLink software, you can use LapLink Everywhere to connect. See page 22.

When you use Connect over LAN (Network), you must supply the computer’s IP address, not an address published
through an ILS.
Connect over LAN (Network) is most useful when you connect to computers whose IP addresses never change. For
more information about using Connect over LAN (Network),
see page 30.
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Making a computer available for ILS connections

I

nternet connections, like e-mail messages, need addresses. To make your computer available to other
LapLink computers on the Internet, publish its address through an ILS (Internet locator service). Any
LapLink user who knows this address can then locate your computer on the Internet and open
connections from anywhere in the world. As a free service to our users, LapLink maintains the LapLink
ILS server to promote Internet connections between computers running LapLink.

To allow other LapLink computers to
connect to a computer on the Internet, set up LapLink to have the computer’s address published through the
LapLink ILS.
In Internet Directory Options, specify
an e-mail address or some other
unique identifier as the Internet
address.
Then notify other LapLink users so
that they can connect by supplying
the Internet address you have specified.

Connecting to computers on the Internet is easy—when
you know their IP addresses. But IP addresses can be hard
to determine, and they often change. If you dial in to an
Internet service provider, for example, your computer may
be assigned a different IP address each time you go online.

26

So how do you make your computer available to other
LapLink computers on the Internet? You have your e-mail
address (or other unique identifier) “published” as your Internet address. You then let other LapLink users connect to
your computer by telling them your Internet address.

. . . Making a computer available for ILS connections
NOTE If the computer is behind a firewall, there are additional requirements. See page 28.
Use LapLink to specify the address to be published and
when it will be published—for example, whenever you are
using LapLink on the Internet.
Use the LapLink ILS to publish your address; the directory is
available without cost to LapLink users, and you don’t have
to sign up to use it.
NOTE Publishing your Internet address does not open
your computer to unwanted connections. LapLink users
who know your published address can connect; others
cannot, even if they are using NetMeeting or other programs that rely on Internet directories.
To set up LapLink to have your computer’s address
published on the Internet:
1 On the Options menu, click Internet Directory Options.
2 In the Internet Address box, type your e-mail address or
another unique identifier.
This will be your Internet address. Give it (as well as login name and password) to any LapLink user you allow to
connect to your computer on the Internet.
3 Set options to determine how to publish your Internet
address:

• To publish the address yourself, without a confirmation dialog box, clear this box: When Manually Publishing My Address, Show Confirmation.
• To have LapLink publish your address for you, check
this box: Automatically Publish My Address When
I’m Connected.
4 Set the Internet directory to publish your computer’s
address like this: Use a LapLink Directory Server:
ils.laplink.com
5 Click OK.
TIP In addition to publishing a computer’s Internet
address, you must also change its security setup before
other computers can connect over the Internet. For more
information, see page 46.

Publishing your Internet address
You can set up LapLink to publish your address automatically whenever you run LapLink on the Internet (step 3,
above). Or you can publish it yourself.
To publish your Internet address yourself:
1 Connect to the Internet as usual.
2 On the Connect menu, click Publish My Internet Address.
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Making an Internet connection to a computer behind a firewall

I

f one of the computers you want to connect to is behind a firewall, you can use LapLink’s Firewall
Connection Service to make the connection. For example, if you want to connect to your work computer
from home and your work computer is behind a corporate firewall.
When the computer outside the firewall requests a
connection, the computer inside the firewall uses
the Address Book entry to initiate the connection.
The Log-in name and password in the Log-in List
entry must match the log-in name and password in
the Address Book entry.
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. . . Making an Internet connection to a computer behind a firewall
You must configure both computers before you can make a
firewall connection. First, configure the computer inside the
firewall to accept incoming connections by using a Log-in
List or by configuring a Public System (Log-in List is more
secure) and then create an Address Book entry.
You must also create a Log-in list entry on the computer outside the firewall. This entry must match the Address Book
entry you created on the computer inside the firewall.
NOTE If you are sharing your computer with someone
other than yourself, you will need to coordinate the firewall
configuration with that other person.
TIP As an easier way of dealing with a firewall, consider
using a LapLink Everywhere connection. See page 22.

Before you connect to a computer behind a
firewall:
• Both computers must be connected to the Internet.

• The computer outside the firewall must be configured to
allow incoming connections. See page 46.
• The TCP/IP ports must be enabled in LapLink on both
computers. See page 137.
• LapLink must be running on both computers.
NOTE For additional security, LapLink allows users to
change the port number that they want to connect through.
For more information about Variable Port Allocation, see
the readme file located in the LapLink Gold application
directory.
Connecting to a computer behind a firewall:
1 Connect to the Internet as usual.
2 On the Connect menu, click the Connect over ILS.
3 If you have created an Address Book entry for the connection you want to open, click the connection in the Connections list.

• The computer inside the firewall must publish its Internet address through the LapLink ILS server. See page
26.

Otherwise, click Manual Connect. Type the Internet
address, log-in name, and password for the computer
behind the firewall.

• The computer inside the firewall must have an Address
Book entry that includes the unique computer name,
user name, and password for the computer outside the
firewall.

NOTE You can get this information from the owner of the
computer behind the firewall.
4 Under Services, check the services you want to use.
5 Click OK.
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Connecting over an office network

C

onnect to any other computer running LapLink on your office network (LAN) and use Remote Control,
File Transfer, or another LapLink service. Use Connect over LAN (Network) and click the name of the
computer you want to connect to or supply its network address.

Use Connect over LAN
(Network) to link computers on an office network.
You can click the name of
a computer or switch to the
TCP/IP Addresses tab and
type the computer’s IP
address.

You can open a LapLink connection to another computer on
your office network, whether it is an IPX (Novell NetWare)
network or a TCP/IP network.
NOTE To simplify routine connections over a network, create Address Book entries. See page 32.
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You can often open a network connection simply by clicking
the computer’s name in a list of LapLink computers on the
network. To open a connection to a computer that lies outside your portion (subnet) on a TCP/IP network, however,
you must provide the computer’s TCP/IP address. (There is
no list to choose from.)

. . . Connecting over an office network
Before you use Connect over LAN (Network)
• The security setup of the remote computer (the one you
are connecting to) must be configured to allow incoming connections. See page 46.
• The network ports (either TCP/IP or IPX) must be
enabled in LapLink on both computers. See page 135.
• LapLink must be running on both computers.
NOTE Not only does Connect over LAN (Network) work
over local networks, it also connects over the Internet. For
details see page 25.

3 Under Services, check the services you want to use, such
as File Transfer and Remote Control.
4 Click OK.

Finding a TCP/IP address
To find out a computer’s TCP/IP address in Windows 95
or Windows 98:
1 On the Options menu, click Port Setup.
2 Click TCP/IP Network in the Ports list, and then click the
Configure button.

To connect to another computer by network:

3 The TCP/IP address appears in the IP Address box.

1 Click the Connect Over button on the LinkBar, and then
click Network.

To find out a computer’s TCP/IP address in Windows
NT:

2 In the Connect over LAN (Network) dialog box, click the
name of the computer you want to connect to.

1 Click the Windows Start button, point to Programs, and
click Command Prompt.

If the computer is not listed and you are attempting to
connect over a TCP/IP network, click the TCP/IP
Addresses tab. Then do either of the following:
• In the Connections list, click the name of the computer you want to connect to.1
• Under TCP/IP Name or Address, type the IP address
of the computer.
1 The computers in the Connections list are those you have
placed in Address Book. For information about creating
Address Book entries for Dial-Up Networking connections,
see page 20.

2 Type IPCONFIG and press ENTER.
The TCP/IP address for that computer appears in the IP
Address line.

Filtering the list of available network computers
You can display the name of a particular computer in the
Connect over LAN (Network) dialog box by typing all or part
of the name in the Computer Name Filter box; then click
Refresh List.
To display the names of all available computers again, click
the arrow next to the Computer Name Filter box, click All
Computers, and then click Refresh List.
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Using Address Book for network connections

S

implify the process of opening connections by making Address Book entries for network computers
you frequently connect to. In each entry you store the kind of network connection, the kinds of services
(such as File Transfer and Remote Control) to be opened automatically, and the password. When you
use Connect over LAN (Network), this information is passed on to the remote computer for you.

For network connections
you make again and
again, simplify the connecting process by adding
entries to Address Book.
Then access the information you store in these
entries when you use Connect over LAN (Network).

When you connect over a local network, you may be able to
choose from a list of computers currently available on the
network. If not, you type the computer’s network (TCP/IP)
address. When you create an Address Book entry for a network connection, you designate which of the two types of
connections you are using:
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• Network: Available Now For connections that
appear in the list of currently available connections.
• Network: TCP/IP Address For connections that
require a TCP/IP address.

. . . Using Address Book for network connections
To create an entry in Address Book for a network connection:
1 Click the Address Book button on the LinkBar and then
click the Add button.
2 In the Description box, type a brief description of the remote
computer for reference.
3 In the Computer Name box, type the exact LapLink name
assigned to the remote computer.
4 In the Connection Type list, click Network Available Now or
Network TCP/IP Address.
5 If you selected Network TCP/IP Address, type the IP
address of the remote computer under TCP/IP Address.
For help in determining a computer’s IP address, see
page 31.
6 Under Services, check the services you want to open when
you connect to the remote computer, such as File Transfer
and Remote Control.
Your requests for services in Address Book will be honored only if the security setup of the remote computer
permits.
7 Under Host Locking on Connect, check the kind of locking, if
any, you want to take effect on the remote computer when
you connect for Remote Control.
You can lock a host (that is, blank its screen or disable its
mouse or keyboard) only if it has been set up to allow
locking.

8 Under Security Information to Send, type the log-in name
and the password you must provide in order to gain access
to the remote computer. Reenter the password to confirm.
When you have finished the entry, you see Address Book
and the description of the new entry. If you want to create
another entry, click Add again and complete the entry.
Otherwise, click Close.
TIP To edit an entry in Address Book, click the entry, and
then click Edit. To copy an entry for revision as a new
entry, click Copy. To delete an entry, click Delete.

Entering passwords
LapLink Gold passwords are case-sensitive (i and I, for
example, are treated differently). In Address Book entries
for connections to other computers running LapLink Gold,
type passwords exactly as they were typed on those computers, using capital letters and lowercase letters as necessary.
NOTE Passwords in LapLink Pro, LapLink Tech, or
LapLink 7.5 or earlier are not case-sensitive. For connections to computers running any of these earlier versions,
type passwords in ALL CAPITAL LETTERS. If you have
old Address Book entries for such connections, retype
their passwords in all capital letters.
NOTE Because of the change in case sensitivity, Address
Book entries created in an earlier LapLink version may no
longer let you connect to computers that have also
upgraded. Have new passwords set up on those computers; then change your Address Book entries to match versions.
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Connecting by cable

W

hen you connect two computers by LapLink cable, attach the cable—serial, parallel, or USB—to
both computers and start LapLink on both computers. Autoconnect, the default setting for cable
connections, opens a connection automatically. To manually connect, click the Connect Over button on
the LinkBar, and then click Cable.
The blue LapLink serial cable
has two connectors at one
end, but only one connector is
attached at a time: Use the
larger connector if one of the
computers has a 25-pin serial
port. Otherwise, attach one of
the smaller connectors to each
computer.

Attach one end of
the yellow
LapLink parallel
cable to a parallel
port on each
computer.
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Attach one end of
the LapLink USB
cable to a USB
port—or USB
hub—on each
computer.

. . . Connecting by cable
Choose the type of cable—serial, parallel, or USB (Universal Serial Bus)1 Network—you are going to use based on
the cables and ports you have available.
Ports are the connectors to which you attach cables and
peripherals like printers and external modems. To find out
which types of ports are available, consult the documentation or the Windows Device Manager for your computer.
Once you decide which kind of cable connection you’ll use,
plug a LapLink cable into both computers: attach a LapLink
serial cable to a serial port on each computer, a LapLink
parallel cable to a parallel port on each computer, or a
LapLink USB cable to a USB port or a USB “hub” device on
each computer.

Before you connect by cable
• Attach an end of a LapLink cable to each computer.
• Ensure that the proper port—serial, parallel, or USB—is
enabled in LapLink on both computers. See page 139.
• Run LapLink on both computers.

serial cables. And USB cables, the fastest of the three,
transfer up to many times faster than serial cables.
In addition, you can attach a USB cable to any USB peripheral that incorporates a “hub” to which other devices can be
connected. This feature lets you use more than one USBcompatible device at a time.

Connecting to another computer by serial,
parallel, or USB cable
When you start LapLink on two computers connected by
cable, they will automatically connect. Autoconnect, the
default setting for cable connections, causes the computers
to connect automatically. If you change this setting, you can
connect to the other computer manually.
TIP If the connection does not open automatically, click
Port Setup on the Options menu and verify that the appropriate port (COM, LPT, or USB) is enabled for cable.
To manually connect to another computer by serial,
parallel, or USB cable:

Cables to use for LapLink connections

1 Click the Connect Over button on the LinkBar, and then
click Cable.

For a serial, parallel or USB connection use a LapLink
cable, available from LapLink.

2 In the Connection list, click the name of the computer you
want to connect to.

If there is more than one type of port available to you,
remember that parallel cables transfer data faster than

3 Under Services, check the services you want to use, such
as File Transfer and Remote Control.
4 Click OK.

1 Not all connection types are supported in all Windows
operating systems. See the table on page 15 for more
information.

TIP To turn Autoconnect off, click Connect Options on
the Options menu. On the Connect tab, clear the Enable
Autoconnect box.
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Connecting by wireless

T

o connect to another computer using wireless devices, simply start LapLink, and the connection opens
automatically. Autoconnect, the default setting for wireless connections, lets computers connect
automatically when you run LapLink. To connect manually, click the Connect Over button on the LinkBar,
and then click Wireless.
Connect over Wireless
works automatically,
connecting two computers when their infrared
or other wireless
devices are within range
of each other.

Using LapLink, you can open short-range connections
between computers equipped with infrared and other wireless devices.1

• Run LapLink on both computers.

You can also connect using other wireless devices: With a
cellular modem, use Connect over Modem. With a wireless
LAN adapter, use Connect over LAN (Network).

When you start LapLink on both computers, a connection
opens automatically over their wireless devices. Autoconnect, the default setting for wireless connections, forces the
computers to connect to each other. If you change this setting, you can connect to the other computer manually.

Before you connect by wireless
• Prepare your infrared or other wireless devices to communicate with each other.
• Ensure that the wireless port on each computer is
enabled in LapLink. See page 141.
1 Wireless connections are not available in Windows NT or
Windows 2000.
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Connecting to another computer by wireless

TIP If the connection does not open automatically, click
Port Setup on the Options menu and verify that the appropriate COM port is enabled for wireless communications.
To manually connect to another computer by wireless:
1 Click the Connect Over button on the LinkBar and then
click Wireless.

. . . Connecting by wireless
2 In the Connection list, click the name of the computer you
want to connect to.
3 Under Services, check the services you want to use, such
as File Transfer and Remote Control.
4 Click OK.
TIP To turn Autoconnect off, click Connect Options on
the Options menu. On the Connect tab, clear the Enable
Autoconnect box.

Using infrared devices
The infrared devices you use in LapLink must first be set up
in Windows 95 or Windows 98. The Windows infrared driver
supports a variety of built-in devices, including fast infrared
devices, as well as adapters connected to serial ports. If the
driver is not installed on your computer, you can download it
from the Microsoft site on the Internet.
TIP When you install the infrared driver, specify any
COM port from COM1 to COM9 as the redirected port. In
LapLink, click Port Setup (Options menu) and enable the
same redirected port for wireless communications.
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Connecting over CAPI 2.0/ISDN

Ibothf CAPI
2.0/ISDN lines are available to your computer and the computer you are connecting to—and
computers are set up for CAPI 2.0/ISDN communications—you can open a high-speed connection
and use Remote Control, File Transfer, and other LapLink services. To connect, click the Connect Over
button on the LinkBar, and then click CAPI 2.0/ISDN.

Use Connect over CAPI 2.0/
ISDN to link computers wherever the CAPI 2.0 version of
ISDN is available.
Entries you have created for
CAPI 2.0/ISDN connections
in Address Book appear in
the connection list to make
connecting easier.

CAPI 2.0/ISDN is an implementation of ISDN, an international communications standard for sending voice, video,
and data over digital telephone lines, at faster rates than
those possible using modems.
NOTE LapLink does not offer CAPI 2.0/ISDN as a means
of connecting unless CAPI 2.0/ISDN is installed on your
computer.
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CAPI 2.0/ISDN is widely used in Europe, particularly in Germany. In North America ISDN seldom is implemented as
CAPI 2.0, but you can still use your ISDN device for highspeed LapLink connections. If you use your ISDN device as
a modem, use Connect over Modem in LapLink. If you use
it to dial in to, and log on to, a network, use Connect over
LAN (Network) in LapLink.

. . . Connecting over CAPI 2.0/ISDN
Before using Connect over CAPI 2.0/ISDN
• A CAPI 2.0/ISDN adapter and driver must be installed
on both computers.
• Both computers must be running a version of LapLink
that supports CAPI 2.0/ISDN.
• The security setup of the remote computer (the one you
are connecting to) must be configured to allow incoming connections. See page 46.

directly from Address Book, you can choose among its
entries when you connect to a remote computer.
To create an entry in Address Book for a CAPI 2.0/ISDN
connection:
1 Click the Address Book button on the LinkBar and click
the Add button.
2 In the Description box, type a brief description of the remote
computer as a reference.

• CAPI 2.0/ISDN ports must be enabled in LapLink on
both computers.

3 In the Computer Name box, type the exact name assigned
to the remote computer in LapLink.

• LapLink must be running on both computers.

4 In the Connection Type list, click CAPI 2.0/ISDN.

Connecting to a computer over CAPI 2.0/ISDN
To connect to a computer over CAPI 2.0/ISDN:
1 Click the Connect Over button on the LinkBar, and then
click CAPI 2.0/ISDN.
2 Click the name of the computer you want to connect to in
the Connection list or type a phone number under Dialing.

5 Under Phone Number, type the phone number.
6 Under Services, check the services you want to use when
you connect to the remote computer (such as File Transfer
and Remote Control).
TIP Requests for services in Address Book will be honored only if the security setup of the remote computer permits.

The connections listed under Manual Dial are your
Address Book entries for CAPI connections. To create a
new entry, click Address Book.

7 Under Security Information to Send, type the log-in name
and the password you must provide in order to gain access
to the remote computer. Reenter the password to confirm.

3 Under Services, check the services you want, such as File
Transfer and Remote Control. You can choose any combination of these services.

For connections to other computers running LapLink
Gold, type passwords exactly as they were typed on the
other computers; that is, use capital letters and lowercase letters as necessary.

4 Click the Dial button.

Dialing from an Address Book entry
Before dialing a computer, it’s a good idea to create an entry
for that connection in Address Book. Though you do not dial

TIP For passwords to computers running earlier versions
of LapLink, type passwords in ALL CAPITAL LETTERS. If
you have old Address Book entries for such connections,
retype their passwords in all capital letters.
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Changing CAPI 2.0/ISDN performance in LapLink

B
efore using CAPI 2.0/ISDN in LapLink, you may want to customize the way that LapLink responds to
CAPI 2.0/ISDN calls and uses the two channels available for LapLink communications. For example, you
can specify that LapLink not respond to any incoming calls to a particular channel, or you can double the
rate at which data is transmitted over your CAPI 2.0/ISDN connections.
In Port Setup, you can
modify the way LapLink
implements CAPI 2.0/
ISDN connections.
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. . . Changing CAPI 2.0/ISDN performance in LapLink
To change CAPI 2.0/ISDN performance in LapLink:
1 On the Options menu, click Port Setup.
2 Under Port Settings, click CAPI.
3 Click the Configure button.
4 If you do not want LapLink to answer any incoming CAPI
2.0/ISDN calls, clear the Enable box under Auto Answer.
To answer calls to only one number, type the number in
this box: Accept Calls Only on the Following Numbers.
5 If you want to combine the two CAPI 2.0/ISDN channels for
faster connections, check the Enable box under Channel
Bonding.
Be sure that channel bonding is also enabled on the
computer you will connect to.
6 Customize the Timeout options as necessary.
The Callback Timeout, Callback Delay, and Redial Delay
settings are specified in seconds.
7 Click OK.

Answering calls
At the outset, LapLink is set up to answer all incoming CAPI
2.0/ISDN calls on both channels. You can modify this so
that it does not answer any of these calls or it answers calls
to just one of the channels.

TIP If you don’t want LapLink to answer any incoming
calls, clear the Enable box under Auto Answer; then make
sure that the Accept Calls Only on the Following Numbers
box is blank.
TIP When typing the number to accept calls to, use only
numerals; avoid characters like dashes, parentheses,
slants, and periods. When typing more than one number,
use a semicolon to separate them.

Channel bonding
CAPI 2.0/ISDN provides two channels that can be used for
LapLink communications. Each channel has a transmission
speed of 64 Kbps. By combining (“bonding”) these channels, the transmission rate can double to 128 Kbps.
At the outset, LapLink does not use channel bonding, even
when both channels are available. This setting keeps transmission costs to a minimum for users who pay additional
fees for each channel connection.
For faster transmissions, enable channel bonding. When
both channels are available, LapLink can then transmit at
speeds up to 128 Kbps.
TIP Be sure to enable channel bonding on both computers. LapLink may not be able to make a connection
between them otherwise.
TIP When one channel is already in use, LapLink uses
the available channel to transmit at 64 Kbps, even when
channel bonding is enabled.
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Connecting automatically

O
nce you have established a connection, you can save it for easy restoration later. You can restore a
saved connection by double-clicking a shortcut icon, setting up LapLink to restore the connection
automatically when you start LapLink, or restoring the connection while running LapLink. When LapLink
restores a connection, it connects to the same computer or computers and opens the same services.
You can restore a saved connection three ways:

• Double-click its desktop icon.
• Set up LapLink to restore the connection
automatically, whenever you run LapLink.
• Restore the connection yourself, while
using LapLink.

Instead of spending time connecting to the same computer
and opening the same services time after time, you can
save the connection and use the saved connection as a
convenient way to reconnect later.
NOTE To connect to several computers at once, open
connections to those computers before saving connections.
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When you save a connection, you record such details as
the number and types of connections (modem, network,
Internet, cable), the names of computers, and the kinds of
services in use. Each connection is saved as a file. Opening
the file reopens the connections and services and arranges
windows to appear much as they did before.

. . . Connecting automatically
Saving a connection
To save a connection:
1 Open one or more connections as usual.
2 On the Connect menu, click Save Connections.
3 In the File Name box, type a name to identify the connection
file.
4 Click Save.
5 When asked whether you want a shortcut icon for this connection on your Windows desktop, click Yes or No.

Restoring a saved connection
Once you have saved a connection, you can restore it three
ways:
• If you created a shortcut icon on your Windows desktop, double-click the icon.

2 On the Startup tab, check this box: Restore Saved Connections at Startup.
3 Click the name of the connection file you want to open, or
type it in the Connection File box.
If the file does not appear in the list of files, click the
Browse button and locate the drive and folder containing
the file.
TIP Connection files have the .LLC extension. In Windows 95 and Windows 98, they are stored in the My Documents folder. In Windows NT, they are stored in the
\Profiles\yourname\Personal folder within the Windows
folder (where yourname is your Windows NT logon
name).
4 If you want the connection restored without confirmation,
click Automatically Connect at Startup. Otherwise, click Ask
Before Connecting.

• Set up LapLink to restore the connection when you run
LapLink again.

5 Click OK.

• Open the connection file while running LapLink.

1 On the Connect menu, click Restore Connections.

NOTE To completely automate the connection process,
create entries in Address Book for saved connections.
Include the log-in name and password required to open
each connection.

2 Click the name of the connection file you want to open, or
type it in the File Name box.

To set up LapLink to restore a saved connection when
you start the program:

To open a saved connection while running LapLink:

If the file does not appear in the list of files, locate the
appropriate drive in the Look In box; then double-click the
folder containing the file.
3 Click Open.

1 On the Options menu, click Connect Options.
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3 Setting up
security for
incoming
connections
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Allowing incoming connections
Denying access to certain drives and folders
Locking out password crackers
Allowing or requiring callbacks
Protecting your security settings with a password
Encrypting information over incoming connections

Allowing incoming connections

A
fter you install LapLink, you can make outgoing connections to other computers, but other computers
cannot open incoming connections to yours except by cable or wireless. To allow incoming connections,
change the security setup to Protected System and create one or more entries in the Log-in List. In each
entry, specify the password and the log-in name the user must provide to open an incoming connection,
and grant the user permission to use services and other features.
Click Log-in List
Only (Protected
System) and then
click the Log-in List
button.

The safest way to allow incoming connections is to set up
password-protection by creating entries in the Log-in List. If
you will be the only person to connect to this computer,
make a single Log-in List entry and grant yourself whatever
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Create an entry in
your Log-in List for
the remote user.

privileges you want. For other users, create separate entries
for each user or group of users according to privileges
granted.

. . . Allowing incoming connections
To set up password-protected access to your computer:

case letters. The introduction of case sensitivity has these
important consequences:

1 Click the Security button on the LinkBar.

CAUTION For incoming connections from computers running versions earlier than LapLink 2000,1 type passwords
using ALL CAPITALS. If your Log-in List has passwords
for such connections, retype them as all capitals, or assign
new passwords.

2 On the General tab, click Log-in List Only (Protected
System).
3 Click the Log-in List button, and then click the Add button.
4 On the General tab, type the log-in name and the password
the user must provide to make a connection to your
computer.
Reenter the password and click OK to confirm.
5 Under Services, check File Transfer, Remote Control, or
any of the other services you want to make available to the
user.
6 Under Locking Permissions, check options to determine
whether the user can blank the screen of your computer
and disable its mouse and keyboard.
TIP You can grant locking permissions only if you select
Remote Control as an available service.
7 To deny access to particular drives and folders, click the
Folder Security tab. For more information see page 48.
8 To specify whether or how a user opening a connection by
modem is to be called back, click the Modem Callback tab.
For more information, see page 52.

Specifying passwords
LapLink Gold passwords are case-sensitive (i and I, for
example, are treated differently). For incoming connections
from computers running LapLink Gold, you can specify
more secure passwords by mixing capital letters and lower-

CAUTION If your Log-in List contains passwords
assigned in an earlier LapLink version, other computers
that have also upgraded may not be able to connect to
your computer until you assign new passwords.

Setting up a public system
If security is not an concern, you can open your computer to
any LapLink users. Though you do not require that they
type a password, you can limit the services, drives, and folders they can access.
To allow access to your computer without password
protection:
1 Click the Security button on the LinkBar.
2 On the General tab, click Anybody (Public System). Then
click the Public Privileges button.
3 On the General tab, check the services and locking
privileges you want to grant.
4 On the Folder Security tab, deny access to drives and
folders as you wish. For more information see page 48.
1 Versions before LapLink 2000 include LapLink Pro,
LapLink Tech, and LapLink 7.5 or earlier.
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Denying access to certain drives and folders

W

hen you open your computer to incoming connections, you specify whether all drives and folders—
or only certain ones—are accessible to users who connect to your computer for File Transfer. You can
deny access to an entire drive or to any parts of one, and you can grant different privileges to different
users.
Folders removed from access in a
Log-in List entry...
...do not appear in File Transfer windows on a remote computer.

Opening your computer to incoming connections does not
mean that files on all your drives and folders must be accessible to other users. You can “hide” certain drives and fold48

ers so that other users will not see them in their File Transfer
windows and cannot copy files to or from them.

. . . Denying access to certain drives and folders
CAUTION Denying access to a drive or folder makes it
invisible to anyone who connects for File Transfer but has
no effect in Remote Control. Anyone who connects for
Remote Control can still access all of your files.
You can set up drive and folder security when you secure
your computer using the Log-in List. Specify a different
setup for each entry in the list if you like.
Until you specify otherwise, every user in your Log-in List
has access to all of your drives and folders.
To limit access to certain drives and folders:
1 Click the Security button on the LinkBar.
2 Ensure that Log-in List (Protected System) is selected, and
click the Log-in List button.
3 Click the Add button to create an entry in the Log-in List.

TIP If you want to change an existing entry, highlight it in
the list of current users and click the Edit button.
4 Click the Folder Security tab and then click Only Allow
Access as Specified Below.
Access is now denied to all drives and folders.
TIP You can navigate through the drives and folders on
the Folder Security tab much as you do in a File Transfer
window. For fastest navigation, double-click a drive or
folder or click the plus sign beside it.
5 In the list of drives and folders, highlight each one you want
to make accessible and click the Allow button.
TIP You can also specify drive and folder security for a
computer designated as a public system (no password
required). Click the Security button on the LinkBar and
click the Public Privileges button. Then click the Folder
Security tab.
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Locking out password crackers

W
hen you open your computer to incoming connections, it’s a good idea to include Lockout protection
so that anyone who supplies an incorrect password more than a particular number of times is denied
access to your computer. You enable Lockout and set the number of allowable tries as part of Security
setup.

Use Lockout to protect
against someone who
attempts to guess your
passwords.
As set up here, Lockout
will take effect after five
failed attempts for any login name.

Someone supplying the
log-in name NormaJean
has been locked out and
won’t be able to connect
even if he or she supplies
the correct password.

Like combination safes, security passwords can be
cracked. Password crackers use a variety of techniques;
some techniques are more sophisticated than others, but
almost all require guessing.
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To guard against unauthorized access, use Lockout to bar
anyone who makes repeated attempts at guessing a password for entry to your computer.
Suppose you are setting up your office computer for access
from home. In the Log-in List of LapLink security, you assign
yourself both a log-in name and a password.

. . . Locking out password crackers
Though you are careful to specify as secure a password as
possible, you still want to have Lockout as additional protection. So you instruct LapLink to refuse entry after a certain
number of incorrect passwords.

You can reset to zero the count for any or all of the log-in
names. This action also makes a locked out name usable
once again.

To lock out anyone who repeatedly tries to connect
using incorrect passwords:

TIP Unless a log-in name has been labeled Locked Out,
its count is reset to zero automatically whenever a user
connects using that log-in name and the correct password.

1 Click the Security button on the LinkBar.

To reset to zero the count for a single log-in name:

2 On the Lockout tab, check this box: Lock Out User after
Repeated Wrong Passwords.

• Click the log-in name and click the Reset User button.

3 In the Lock Out After This Many Wrong Passwords box,
click the number you want to allow before Lockout takes
effect.

• Click the Reset All button.

TIP The lower the number, the less the security risk.

• Use at least six characters.

4 Click OK.

Monitoring failed log-in attempts
Lockout is designed to monitor and control access according to the log-in names in your Log-in List. A separate count
of failed attempts is kept for each log-in name; when a count
reaches your maximum (step 3 above), users can no longer
connect using that log-in name.
Beside the log-in names listed on the Lockout tab appear
numbers for the number of incorrect passwords. When a
count reaches the maximum, the log-in name is labeled
Locked Out.

To reset to zero the count for all log-in names:

Tips for more secure passwords
• Include letters (both lowercase1 and capitals), numbers, punctuation, and symbols.
• Avoid any words found in dictionaries. (Some password-cracking programs rely on dictionaries to guess
passwords.)
• Don’t make your passwords so complex or long that
you can’t remember them.
• Change your passwords every 45 days.
1 Passwords for incoming connections from versions earlier
than LapLink 2000 are the exception. They must be all
capital letters.
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Allowing or requiring callbacks

W

hen you allow incoming modem connections, you can require that the remote computer be called
back before a connection is opened. Or you can let the remote computer determine whether to be called
back. In both cases you can supply the phone number ahead of time or leave the number to the other
computer. You set callback options in the Log-in List.
Hello. I’ll call you
back if you give
me your current
phone number.
Otherwise, I’ll connect you without
reversing the call.

Hello. Do you
want me to call
you back at
555-1111?
Otherwise, I’ll connect you without
reversing the call.

A callback occurs when a remote computer attempts to
connect to your computer by modem; instead of completing
the connection, LapLink reverses the call by hanging up
52

Hello. I’ll call you
back if you give me
your current phone
number.
Otherwise, I’ll have
to disconnect.

Hello. Do you want
me to call you back
at 555-2222?
Otherwise, I’ll have
to disconnect.

and then dialing the remote computer. The connection to
your computer is completed when the remote computer
answers.

. . . Allowing or requiring callbacks
You can use callbacks as a security measure: require a callback to a phone number you specify. Or you can use callbacks to save money, as when you are connecting to your
office from a hotel room.
You can set callback options when you secure your computer using the Log-in List. Specify a different option for
each entry in the list if you like.
To set callback options:
1 Click the Security button on the LinkBar.
2 Ensure that Log-in List (Protected System) is selected and
click the Log-in List button.
3 Click the Add button to create an entry in the Log-in List.
TIP If you want to change an existing entry, highlight it in
the list of current users and click the Edit button.
4 Click the Modem Callback tab.
5 Click one of these options:
• None Prevents callbacks.
• Optional, Any Number Lets the remote user
decide whether to be called back; users who choose
to be called back can specify the number to dial. This
is the most flexible of all the options.

• Optional, Specified Number Only Lets the
remote user decide whether to be called back to the
number you specify or to open the connection without any callback. Only the number you specify in the
Phone Number box can be dialed for the callback.
• Required, Any Number Requires remote users to
be called back but allows them to specify the number
to be dialed. The number can vary from session to
session.
• Required, Specified Number Only Requires the
remote user to be called back to the number you
specify in the Phone Number box.
6 If you clicked either of the options for which you must specify
a phone number, type that number in the Phone Number
box.
Type the entire number, including any prefixes or suffixes
necessary to dial the remote computer from this one.
(Your Dialing Properties settings do not apply here.)
TIP Do not require callbacks from computers that connect by running Xchange Agents. The agents will not finish
because they cannot perform callbacks.
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Protecting your security settings with a password

C

reating password protection for your LapLink security settings prevents unauthorized users from
compromising your security system; it also keeps them from viewing your Address Book entries and
using them to open connections to other computers. Protecting your security settings is a particularly
good idea if you allow others to control your computer remotely.

On the Local Security tab
in Security, check the Protect Local Security with a
Password box. Then click
the Set Password button.

Setting up password protection for your LapLink security
settings ensures that the protections you set up for your
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computer cannot be compromised—either by someone
using your computer in your absence or by remote users.

. . . Protecting your security settings with a password
Without knowledge of your password, users cannot view or
change any of this information:
• Log-in names, passwords, and other security settings
• Phone numbers, passwords, and other information
stored in your Address Book entries
• Privileges you have granted to guest computers and
other settings in Remote Control Options
In addition, the same password is required for access to
Connect over Modem and certain Logging features.
To protect your LapLink security settings:
1 Click the Security button on the LinkBar.
2 On the Local Security tab, check this box: Protect Local
Security with a Password.
3 In the Change Password dialog box, type the password in
the New Password box. In the Confirm New Password box,
type it again.
TIP Passwords are case-sensitive: capital letters and lowercase letters are treated differently. For more secure
passwords, mix the two cases.
4 Click OK.

TIP To remove password protection, clear this box: Protect Local Security with a Password. To change the password currently in effect, click the Set Password button.
TIP By default, security is not imposed on incoming connections over a cable or by wireless. If you set up password protection for modem and network connections,
however, you can extend that protection to cable and wireless connections as well. On the Local Security tab, check
this box: Enforce Security for Local Connections.

Did you upgrade?
In versions earlier than LapLink 2000,1 passwords were not
case-sensitive. If you specified azefgin as your password,
for example, you could gain access to your security system
by typing Azefgin, AZEFGIN, or any number of other combinations.
Beginning with LapLink 2000 and the introduction of case
sensitivity, however, there is only one way to type a password: just as it was typed in the first place. If you inherited a
password from an earlier version of LapLink, try different
combinations of capital letters and lowercase letters: initial
capital letter, all capital letters, and so on.
1 Versions before LapLink 2000 include LapLink Pro,
LapLink Tech, and LapLink 7.5 or earlier.
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Encrypting information over incoming connections

E
ncryption is a good idea over Internet connections and other connections where your information can
be intercepted and compromised. You can choose between two encryption methods: the one available
on earlier versions of LapLink and more secure methods installed on your computer. The settings you
make on a computer determine encryption for incoming connections.
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. . . Encrypting information over incoming connections
By default, LapLink encrypts log-in names and passwords,
but nothing else. This setting is usually fine for transmitting
data over office networks or other secure connections.
On the Internet, intranets, or wide area networks, however,
it is usually a good idea to encrypt your data, including files,
text from chat sessions, and instructions sent to the remote
computer during Remote Control.
While opening your computer to incoming connections, you
determine whether and how data transmitted over those
connections will be encrypted. (The settings on the other
computers are irrelevant.) When you connect to another
computer, however, it is the settings on that computer that
determine encryption.1
To encrypt data over incoming connections:
1 Click the Security button on the LinkBar.
2 On the Encryption tab, check this box: Use Encryption to
Send Data.
3 If you want to limit encryption to connections over a TCP/IP
network or to dial-up connections to a TCP/IP network,
including the Internet, check this box: Only Encrypt When
Connecting over TCP/IP (Internet/Intranet).
1 The only exception occurs when you use LapLink 2000 to
connect to a computer running a version older than
LapLink 2000. In this case only, the settings on your
LapLink 2000 computer determine encryption.

4 Click a method of encryption:
• LapLink-compatible Encryption Provides compatibility with versions earlier than LapLink 2000.
• CryptoAPI Encryption Using the Specified
Provider2 Sets a higher degree of security, using
an algorithm installed on your computer. Cannot be
used in connections with versions earlier than
LapLink 2000.
5 If you clicked the CryptoAPI Encryption option, click a
CryptoAPI provider in the box below the option.
Be sure to specify a provider that is installed on the
remote computer too. That computer cannot connect to
your computer otherwise.
6 If you clicked the CryptoAPI Encryption option—but still
want to accept calls from earlier versions of LapLink (which
lack CryptoAPI)—check this box: Use LapLink Encryption If
Guest Doesn’t have CryptoAPI.
CAUTION This option opens your computer to a lower
level of security than you specified in the previous step.
TIP Be sure to enable encryption before a connection is
opened. Changing the setting during a connection won’t
have any effect until the next connection.
2 CryptoAPI encryption is available only if your computer is
equipped with software written to the Microsoft CryptoAPI.
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Using Remote Control—Overview

W
hen you open a Remote Control window on your computer, the computer in front of you becomes
the guest, and the remote computer displayed on your screen becomes the host. From the guest, you
can view and operate the host as if you were sitting in front of it. Images from the host appear on your
screen in a Remote Control window within the LapLink workplace.
Remote Control provides a way to operate another computer at a distance. You begin Remote Control as soon as
you open a Remote Control window. While you are working
in this window, your mouse moves the mouse pointer on the
remote computer, your keyboard types characters on the
remote computer, and your Remote Control window shows
the remote computer’s screen.

Remote Control terminology
A LapLink Remote Control session creates two kinds of
computers:
Guest The Remote Control window and the mouse and
keyboard on the guest are your links to the remote computer. Working in the Remote Control window, you use your
mouse and keyboard to operate the host. Your work, meanwhile, is being processed on the host computer.
Host There is no special procedure associated with setting
up a host. The computer need only be running LapLink and
configured to allow incoming connections. You do not need
to be at the computer. On the other hand, you may want to
join the guest as an observer or an active participant.

Opening a Remote Control window
On a guest, you can open a Remote Control window at the
time you connect to the host. Or you can open one some-
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time after the connection is made. Because LapLink supports multiple connections, you can maintain several
Remote Control windows, one for each host computer.
To open a Remote Control window while connecting:
• Click the Connect Over button on the LinkBar and then
click Modem, Network, or some other means of connecting. Under Services, check the Remote Control
box. (For more information about connecting to other
computers, see chapter 2.)
To open a Remote Control window after opening a connection:
• Click the Open Remote Control button on the Shortcut
bar. Or click Open Remote Control on the Window
menu.
• If you have more than one connection, select a window
for the desired connection before clicking the Open
Remote Control button.

What you see
The host screen appears on your screen as a window within
LapLink. The name of the host computer appears in the
window’s title bar. You can move, resize, minimize, or maximize the window as you would any other window. Use the
scroll bars to view other parts of the host screen.

. . . Using Remote Control—Overview
If you prefer to display the host screen across your entire
screen instead of a window, press CTRL+SHIFT+F. Press
CTRL+SHIFT+F again to return to the window view. For
more information about changing your view of the host, see
page 62.
TIP A host screen can be made to display full screen by
default. To make this change, click Remote Control
Options on the Options menu. On the Guest tab, check
the Always Use Full-Screen box. The Remote Control win-

dow then alternates between full screen and icon; the window view is no longer available.
TIP There are several ways to customize Remote Control performance—whether you want to enhance your view
of the host or speed up performance. For instance, you
can use solid rather than dithered colors or prevent the
display of large bitmaps. For more information see page
73.
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Viewing the host

A
s a guest, you can alternate between two views of the host screen. Your first view appears in a window
within LapLink. Inside the window, you control the host; outside the window, you perform other tasks, in
LapLink or in other applications on your computer. Switch to a full-screen view when you want to
maximize your view of the host and use Remote Control exclusively. When you cannot see the entire host
screen even in full screen, you can change the resolution of the host screen or scale its image to fit within
your view.

To alternate between a window and a full-screen view of
the host, press CTRL+SHIFT+F.

Devoting your entire screen to a view of the host
You can view the host screen in two ways:
• In a window within LapLink (the default)
• As a full-screen display, hiding LapLink and the rest of
your Windows workspace
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In a window view, you have quick access to File Transfer,
Text Chat, and other LapLink features. You can also switch
to other applications on your computer.
To maximize the area in which you view and control the
host, switch to a full-screen view. Your entire screen is now
devoted to controlling the host; you do not have access to
your own applications. When you want to do something
other than control the host, switch back to the window view.

. . . Viewing the host
To switch between window and full-screen view:
• Press CTRL+SHIFT+F.
TIP In full screen, you can also switch to a window from
the copy of LapLink running on the host: If LapLink is an
icon, click it to restore it to a window. Then click the icon
representing your Remote Control window, and click
Guest Full Screen to clear the check mark.
TIP To make Remote Control alternate between full
screen and icon, bypassing the window view, click Remote
Control Options on the Options menu. On the Guest tab,
check the Always Use Full-Screen box.

Viewing the entire host screen at once
There are two ways to fit the host screen into your view:
• From your computer, lower the resolution of a higherresolution host screen to match that of your screen.
• Scale the image of the host screen to fit within your
view.
Temporarily changing the resolution of the host
screen When using a laptop to control a desktop, you
often can’t view the entire host screen at once if the desktop
operates at a higher screen resolution. From your laptop,
you can lower the desktop’s screen resolution to match your
laptop’s.1

You can then view all of the host screen in full-screen view.
The original resolution is restored automatically on disconnect or at your direction.
To lower the resolution of the host screen to match that
of your screen:
1 On the Options menu, click Remote Control Options.
2 On the Guest tab, check this box: Match Host to Guest.
Clearing the box restores the host to its original resolution.
3 Click OK.
Scaling the image of the host screen to fit You can
also view the entire host screen at once by scaling the
image to fit within the LapLink window. You always see all of
the host’s screen, whether you are working in full screen or
window, though the image may be distorted.
To scale the image of the host screen to fit within your
view:
• Press CTRL+SHIFT+S.
• Pressing CTRL+SHIFT+S again restores the image to
normal.
1 You cannot lower the resolution of a host computer unless
its monitor and display adapter allow the change without
restarting Windows. The host must also be running a version of LapLink that supports this feature.
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Customizing keyboard control

B

y default, Windows system keys pressed on the guest computer take effect on the host. If you want
the system keys to operate on the guest while working in a Remote Control window, click Remote Control
Options on the Options menu. Then on the Guest tab, click Execute on Guest. Through Remote Control
Options, you can also change the key combinations that control your view of the host.
When you are working in a Remote
Control window, CTRL+TAB and
other Windows system keys you
press on your computer (the guest)
take effect on the remote computer
(the host).

To have system keys take effect on
your computer instead of the remote
computer, click Execute on Guest.

Windows system keys
Windows system keys are key combinations that perform a
variety of tasks. Pressing ALT+TAB, for example, switches
to the program you used last. By default, LapLink sends
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most system keys to the host during Remote Control: pressing ALT+TAB on the guest, therefore, switches to the program last used on the host.

. . . Customizing keyboard control
You can make system keys work on your own computer
(the guest) when you are working in a Remote Control window.

full-screen and window view of the host. Pressing
CTRL+SHIFT+S switches between scaled-to-fit and normal
view. (See page 62 for more information.)

TIP Windows system keys (except
CTRL+ALT+DELETE) always take effect on the host
when you are using Remote Control in the full-screen
view.

You can change these default key combinations to certain
other combinations. (To avoid interference with other
LapLink and Windows shortcut keys, you are limited in your
choice of replacements.)

TIP If you intend to control a remote computer using the
keyboard exclusively (without a mouse), set the Windows
system keys to execute on your computer (the guest).
When you want the keys to execute on the remote computer (the host), switch to the full-screen view.

To change the LapLink shortcut key combinations:
1 On the Options menu, click Remote Control Options.
2 On the Guest tab, click in one of these boxes:

To execute Windows system keys on the guest:

• Full-screen Toggle Changes the shortcut key that
alternates between full-screen and window view.

1 On the Options menu, click Remote Control Options,
and then click the Guest tab.

• Scaling Toggle Changes the shortcut key that
alternates between scaled-to-fit and normal view.

2 Click Execute on Guest.
3 Click OK.

Remote Control shortcut keys
LapLink offers two shortcut keys to change your view of a
host screen. Pressing CTRL+SHIFT+F switches between

3 Press any of the following key combinations (where n is a
number or a letter):
SHIFT+ALT+n
CTRL+SHIFT+n
CTRL+ALT+n
CTRL+SHIFT+ALT+n
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Disabling the host keyboard and mouse and blanking its screen

Fkeyboard
rom a guest computer, you can ensure privacy and prevent interruptions at the host by disabling its
and mouse and blanking its screen. To perform any of these “locking” operations from the
guest, click the appropriate command on the Session menu. On the host, you can allow locking by
changing the default security setup.

On the host: Allow users to blank
the screen and disable the keyboard
and mouse when you grant them
access through the Log-in List.

On the guest: Blank the host screen
and disable its keyboard and mouse
on the Session menu.
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. . . Disabling the host keyboard and mouse and blanking its screen
Locking the host from the guest
With the permission of the host computer, you can:
• Blank the host screen The host’s screen is darkened, preventing your work from being viewed at the
host.
• Disable the host mouse The host’s mouse is locked,
preventing anyone at the host from using the mouse to
interrupt your work.
• Disable the host keyboard The host’s keyboard is
locked, preventing anyone at the host from using the
keyboard to interrupt your work.
To lock the host during a Remote Control session:
• On the Session menu, click any of these commands to
place a check mark beside the command: Blank Host
Screen, Lock Host Mouse, or Lock Host Keyboard.
• To disable locking, click the command again to clear the
check mark.
TIP If a command is dimmed, it is not available: either the
host cannot perform the action, or the security setup of the
host computer does not allow it.
TIP The Session menu is available only when you are
connected to another computer.
TIP Through Address Book, you can request the kinds of
locking you want to take effect as soon as you open a
Remote Control session. Your requests will be honored as

long as they are allowed by the host. For information on
using Address Book to make connections, see chapter 2.

Configuring a host for locking
You can configure a host to determine who can lock it and
how it will be locked. Guests cannot lock the host without
your permission, and locking privileges you grant cannot be
changed during a Remote Control session.
Whether you permit any kind of locking depends on how
you intend to use LapLink. If you want to use Text Chat, for
example, there should be no locking.
You grant locking permission by changing the security setup
on the host computer: Click the Security button on the LinkBar. You then have a choice:
• Set up a Log-in List by specifying Log-in List (Protected
System) and adding one or more entries. In each entry,
check any of the three boxes under Locking Permissions. The permissions apply only to guests whom you
provide with the appropriate log-in name and password.
For more information about setting up a Log-in List, see
page 46.
• If security is not an issue, open the system to any
LapLink user by clicking Anybody (Public System).
Click the Public Privileges button. On the General tab,
check the Remote Control box, and then check any of
the three boxes under Locking Permissions. The permissions apply to all guests.
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Rebooting and logging on to the host

Fguest
rom a guest computer, you can reboot a host computer and restart Windows. To reboot a host from the
during Remote Control, click the Reboot Host command on the Session menu. To configure a host
for rebooting and restarting Windows, click Remote Control Options on the Options menu.

On the host: Allow users to reboot
the computer in Remote Control
Options.
On the guest: Reboot the host on
the Session menu.

Rebooting the host from the guest
From a guest computer you may want to restart a host to
put into effect changes you have made on that computer. Or
you may want to restart a host computer to ensure that no
one else can call in after you disconnect.

68

To reboot the host from the guest during Remote Control:
• On the Session menu, click Reboot Host.
If Reboot Host is dimmed on the Session menu, the host
has not set the option to allow rebooting by a guest.

. . . Rebooting and logging on to the host
Logging onto Windows NT from the guest
Depending on how a Windows 95 or Windows 98 computer
is set up, you may or may not be prompted to log on to Windows. On every Windows NT computer, however, you must
always press CTRL+ALT+DELETE before you can log on
to Windows.
To send CTRL+ALT+DELETE to a Windows NT host, do
one of these:
• Press the key combination specified for this purpose on
the host.
• On the host’s Session menu, click Send
CTRL+ALT+DELETE to the Host.
• Click the Remote Control icon at the bottom of the
host’s LapLink workplace, and then click Feed
CTRL+ALT+DELETE.

Configuring the host for rebooting
You must configure a host to allow any guest to restart it
during a Remote Control session. You can also require that
the host be restarted whenever a Remote Control connection is interrupted.
To configure a host computer for rebooting:
• On the Host tab of Remote Control Options (Options
menu), check either or both of these boxes:
• Allow Guest to Reboot on Command Check this
box to allow guests to restart the host using the
Reboot Host command on their computers.

• Always Reboot When Guest
Disconnects Check this box to require that the
host be restarted whenever a guest breaks a connection or the connection is broken accidentally.

Ensuring access to the host after a reboot
At the same time you are configuring a host for rebooting,
you can configure it so that a guest can resume a LapLink
connection after the host is rebooted. You can do this by
setting up LapLink to run whenever Windows is started.
To configure a host so that it automatically runs
LapLink each time Windows is started:
• On the Advanced tab of Program Options (Options
menu), check this box: Always Start LapLink before
Windows Logon Prompt.
Logging on to Windows NT When a Windows NT host
requires the user to press CTRL+ALT+DELETE at logon, a
guest can press a special key combination specified on the
host.
To specify the key combination for
CTRL+ALT+DELETE:
1 On the Host tab of Remote Control Options (Options
menu), click this box: Send CTRL+ALT+DELETE to
This Computer When a Guest Presses This Key Combination.
2 Press one of these key combinations (where n is a number
or letter): SHIFT+ALT+n, CTRL+SHIFT+n, CTRL+ALT+n,
or CTRL+SHIFT+ALT+n.
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Hosting a Remote Control session

W

hen you allow your computer to be controlled from a remote computer, your computer becomes the
host to a guest computer. For Remote Control to take place the host need only be running LapLink—you
do not need to be at the computer. Sensitive information is protected by the conditions of the connection.
You can grant greater access, or limit these conditions, through the LapLink security system.

After installation, change the default
security setting to allow your computer to accept incoming connections and serve as a host.

To host a Remote Control session,
leave LapLink running. (Minimize it if
you wish.)
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. . . Hosting a Remote Control session
When you control a host, you control who can connect to
that computer and the kinds of services they can use. For
example, you can limit a guest to Remote Control only, or
you can allow access to Text Chat and File Transfer as well.
You can even allow a guest to blank your computer’s
screen or disable the mouse and keyboard. All of these
options are set in the LapLink security system.
You can leave the host computer unattended, giving an
authorized user exclusive control. Or you can stay at the
computer and interact with the guest by trading off control.
For example, the two of you could edit a document together,
participate in a training session, or explore a new program.
TIP A host can be controlled by only one computer at a
time. In the meantime, however, other computers can connect to the host using any other services than Remote
Control.

What you see on a host
When a guest connects to your computer and begins
Remote Control, your LapLink workplace is minimized. If
you double-click the icon, the LapLink workplace is restored
to a window.

tified by the name of the remote computer. Clicking this icon
displays a Windows menu with standard commands. Clicking Close closes the Remote Control connection.
TIP You can make the LapLink workplace remain a window when a guest connects: Click Remote Control
Options on the Options menu, and then click the Host tab.
Clear this box: Minimize LapLink When This Computer Is
a Host.

Reversing a Remote Control session
There may be times when the guest and you want to switch
roles so that you become the guest controlling the remote
computer.
To reverse the direction of Remote Control, the current
Remote Control connection must be broken on either computer. Then, as the prospective guest, you open a Remote
Control window and begin controlling the other computer.
TIP To avoid breaking the connection when a Remote
Control connection is closed, make sure that there is at
least one other service window open, such as File Transfer. If Remote Control is the only service in use, open
another service window before closing Remote Control.

At the bottom of the restored LapLink workplace, you see
an icon for the Remote Control connection. The icon is iden-
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Sharing clipboard information with remote computers

C

omputers in a Remote Control connection share a common clipboard: you can copy or cut information
to the clipboard on one computer and paste this information on another. Only information put in the
clipboard during a Remote Control session is available to other computers.
When you cut or copy information for pasting in another
document, the information is stored temporarily in the clipboard. Normally, clipboard information is transferred
between documents on the same computer. When you use
Remote Control, however, you can use the clipboard to
transfer information from one computer to another. You can
copy text or graphics on the host computer, for example,
and paste it on the guest.
If you are controlling several computers at the same time,
information you cut or copy on any of the linked computers
can be made available for pasting on any of the others.
TIP Only information placed in the clipboard during
Remote Control can be pasted on other computers. You
cannot share any information copied or cut to a clipboard
before a Remote Control connection is opened.
TIP When you clear the contents of the clipboard on one
computer, you clear the clipboard contents of the other
computer as well.

Pasting from the clipboard during Remote Control
When you copy or cut information to the clipboard during
Remote Control, only a small part of the information is transferred to the other computer immediately. The rest of the
information is transferred when you paste.
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To prevent the loss of information added to the clipboard
from the remote computer during Remote Control, paste the
information before disconnecting.
If you are controlling several remote computers, information
in the clipboard on your computer is available to any of the
remote computers. If you want to transfer clipboard information from one remote computer to another, however, you
must first paste the information into a document on your
computer; then paste it into a document on another remote
computer.

Disabling clipboard sharing
Clipboard sharing is available during Remote Control sessions unless you disable it.
To disable clipboard sharing:
1 Open a Remote Control connection to another computer.
2 On the Edit menu, click Link Clipboards to clear the check
mark.
If there is data in the common clipboard that hasn’t been
transferred completely, you are asked whether to complete the transfer.
TIP To enable clipboard sharing again, repeat the procedure to restore the check mark to Link Clipboards. Only
data placed in the clipboard after you enable this option
can be shared with other computers.

. . . Customizing Remote Control performance

Customizing Remote Control performance

A
s a guest, you can change several Remote Control settings either to speed up performance or to
enhance your view of the host screen. When speed is your priority, change the settings to enhance
performance. When you want the best view of the host screen, turn off the performance enhancements.
To change performance settings, click Remote Control Options on the Options menu, and then click the
Performance tab.

Choose between enhancing your
view of the host screen and speeding
up Remote Control performance.

Click one of the preset options.

Or click the Settings button and
specify your own settings.

To improve Remote Control performance, LapLink temporarily alters the host screen by removing its wallpaper,
screen saver, and other visual enhancements. You can
restore any of these enhancements. Or you can improve
performance even more by minimizing the number of bitmaps and bitmap colors transferred over a connection.

To change Remote Control performance settings:
1 On the Options menu, click Remote Control Options.
2 On the Performance tab, click either of these options:
• Best Quality Improves the appearance of fonts
and does not change the appearance of the host
screen except to disable its screen saver.
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• Best Performance Displays smaller bitmaps in
black and white and does not show larger bitmaps at
all; also changes the appearance of the host screen
to maximize performance.
3 To customize the settings for any of these options, click the
Settings button.1

Changing your view of the host screen
Click the Settings button in Remote Control Options to
change the quality of your view of the host screen without
affecting the host screen itself.

appear in some dialog boxes, wizards, and buttons. (Experiment with the setting, increasing it as necessary to display
larger bitmaps.)
On the Guest Colors tab, adjust these options:
Use Solid Colors Displays solid colors instead of dithered, or patterned, colors. Performance is not affected, but
your view of the host may improve.
Bitmap Color Selects the palette used to display bitmaps.
The values range from Monochrome to True Color (24 bit).
Choose a palette with fewer colors to improve performance.

On the Guest Display tab, adjust these options:

Temporarily changing the host screen

Send Font Information Displays text and symbols on
the guest computer. Checking this box speeds display performance but may not present the most accurate representation of text and symbols.

Click the Settings button in Remote Control Options to alter
your view of the host by changing the appearance of the
host screen itself. When you disconnect, the host screen is
restored to its original appearance.

Prevent Display of Large Bitmaps Determines the
size of the largest bitmap to be displayed in your view, ranging from 32 by 32 to 512 by 512 pixels. Choosing a smaller
size improves performance but may cause bitmaps not to

On the Host Display tab, change these settings:

1 Performance options are set at Typical during installation.
They are reset to User Customized whenever you click the
Settings button and make changes.
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Disable Screen Saver Keeps the host’s screen saver
from running.
Disable Special Windows Effects Disables several
Windows features, including desktop wallpaper or patterns,
animated windows, and Web Page view.

5 Using File
Transfer
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Using File Transfer—Overview

O

nce you have connected to another computer and opened File Transfer windows, you are ready to
transfer files between the computers. First, display your target, and then select the files you want to
transfer. If you want the files on both computers, copy them. If you want to transfer the files to one
computer and delete them from the other, move the files.

You can open File Transfer windows at the time you connect to a remote computer. Or you can open File Transfer
windows sometime after the connection is made.
NOTE In Windows, folder and subfolder are used in place
of directory and subdirectory.
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To open File Transfer windows:
• Click the Open File Transfer button on the Shortcut bar.
Or click Open File Transfer on the Window menu.
Two File Transfer windows appear: one for the remote
computer, one for your computer. Using these windows,
you can view all the files on any drive on both computers.

. . . Using File Transfer—Overview
Step one: display the target
Since you will be using the drag-and-drop method of copying and moving files, first find your target and make it visible
on your screen. A target is the drive or folder you want to
transfer the files to.
To display the target:
1 Identify the target window: it may be the window for your
computer or the remote computer—whichever you want
to receive the files.
2 On the left side of the target window, double-click the target
drive.
3 Click the target folder. Its contents now appear on the right.
4 If you are looking for a subfolder, click the plus sign (+)
beside the folder containing the subfolder. Then click the
subfolder itself.
NOTE To determine which File Transfer window is which,
look for the computer name in the title bar, at the top of
each window.

Step two: select the files
In the opposite File Transfer window, select the files you’ll
be transferring to the target you just displayed.
To select the folders and files you want to transfer:
• On the right side of the window, click the folder or file
you want to transfer.

• To select more than one item, do either of the following:
• Hold down CTRL as you click each item.
• To select two or more items listed next to each other,
click the first item and press SHIFT while you click
the last item.
NOTE If you prefer, select a group of files or folders by
clicking at a right corner of the group and dragging to the
opposite corner to form a selection box.

Step three: drag and drop
Using the drag-and-drop method simplifies file transfers.
Keep in mind the difference between copying and moving:
Copying puts a copy of the files on the other computer, leaving the originals where they were. Moving puts the files on
the other computer, deleting the originals.
To drag and drop the selected files:
• To copy the files, hold down CTRL and your left mouse
button as you drag them to the target folder.
• To move the files, hold down SHIFT and your left
mouse button as you drag them to the target folder.
TIP If you drag without using CTRL or SHIFT, files are
copied when you drag to a different drive or computer and
moved when you drag to another location on the same
drive.
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Navigating through drives and folders

E

ach File Transfer window is split into a left and a right side. The left side is designed for navigating
through drives and folders: click or double-click a drive or folder to open it and display its contents. On the
right side, you see the contents of the open drive and folder. Commands on the View menu let you
change the appearance and the order of the contents.
Click a drive or folder to open it, without showing its contents.
Double-click a drive or folder to open
it and show its contents.
Click a plus sign to show the contents of a drive or folder without
opening it. Click a minus sign to hide
the contents.
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. . . Navigating through drives and folders
Follow these guidelines to navigate through the left side of a
File Transfer window:
• Double-click a drive or folder Opens and expands
the drive or folder, displaying its subfolders immediately
below. (Double-clicking is the fastest way to navigate
downward in a hierarchy of folders.)
• Click a drive or folder Opens the drive or folder without expanding it.
• Click a plus sign (+) Expands the drive or folder, displaying its subfolders immediately below. The drive or
folder is not opened.
• Click a minus sign (-) Collapses the drive or folder,
hiding its subfolders.
NOTE Want to locate a particular folder or file? Type the
first letter of its name. The highlight moves to the next item
beginning with that letter. Typing the letter again finds the
next occurrence.

Changing the view
When you open a drive or folder, you see its contents—subfolders and files—on the right side of the File Transfer window.

By default, the contents appear in Detail view: file name,
size, type (based on the MS-DOS name extension), modification date, and attributes.
To change the appearance of the items displayed on
the right side of a File Transfer window:
• On the View menu, click one of these commands:
Large Icons, Small Icons, or List.
Try the different views to find your preference. To return to
the original view, click Detail.

Sorting files and folders
Regardless of the view, you can rearrange the folders and
files on the right side of a File Transfer window according to
name, size, date, and so on.
To change the order of files and folders:
• On the View menu, point to Arrange Icons; then click
one of these commands: By Name, By Type, By Size,
By Date, or By Attributes.
TIP If you are displaying files in Detail view, you can sort
them by name, size, type (file name extension), modification date, or attribute: click the corresponding button at the
top of a column. Clicking the same button again reverses
the order.

79

Selecting files and folders

O
n the left side of a File Transfer window, you can select only one folder at a time. On the right side, you
can select multiple folders and files. To select a single item, point to it and click the left mouse button. To
select several items in sequence, click the first item; then hold down SHIFT while you click the last item.
To select items out of sequence, hold down CTRL while you click each one. You can also click Select All
or Select By on the File menu. To cancel an individual selection, hold down CTRL, and click the item.
Select a group of items by dragging
a selection box around them, from
right to left.
Select several items not listed
together by holding down CTRL
while you click the items.

You must select a folder or file before you can copy or move
it. When you select an item, its name and icon are highlighted.
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You can select a single folder on either side of a File Transfer window. You can select files and multiple folders only on
the right side.

. . . Selecting files and folders
NOTE By default, selecting a folder selects all of its files
and its subfolders. To change the default, click File Transfer Options (Options menu). On the Filter tab, clear this
box: Include Subfolders in Copies. (You can always override this setting when you are asked to confirm a copy or
move operation.)
To select a single file or folder:
• Place the mouse pointer on its name or icon, and click
the left mouse button.
To select a group of items, do either of the following:
• Click the first item, and press SHIFT while you click the
last item.

To select folders and files using the Select By command:
1 On the File menu, click Select By.
2 In the Filter box, type the name of a file or folder. Or use wildcards to specify items with similar names.
For example, typing *.DOC selects all files with the .DOC
extension. The default (*.*) selects all files and folders.
You can specify several criteria at once by typing them
one after another and inserting a space or a comma
between them. For example, typing *.DOC,*.TXT displays all files with those extensions.

• Click at a right corner of the group and drag to the
opposite corner to form a selection box.

3 If you want to select according to date, check the Enable
Date/Time Range box. Then type the dates and times
under Oldest File and Newest File.

To select two or more items out of sequence:

4 Click OK.

• Press CTRL while you click the items.
To select all folders and files in the current folder:
•

On the File menu, click Select All.

TIP To select everything on a drive, click the drive and
then click Select All.

Clearing selections
To clear an individual selection:
• Hold down CTRL while you click the item.
To clear all selections:
• On the File menu, click Clear Selection.
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Copying or moving files and folders

O

nce you have displayed the target and selected the items to be transferred, you are ready to use the
Copy or Move command. Or you can use the mouse to drag the items and drop them onto the target.
Before the transfer is completed in either case, you see a confirmation dialog box showing details of the
operation you are about to perform. You can then proceed immediately, change certain conditions, or
cancel the operation entirely.
Before copying or moving, you
can confirm that you have
selected the source and target
as you intended.

When you copy or move, you transfer items from one location—the source—to another—the target. You can transfer
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items using the Copy or Move commands or by dragging
them with the mouse.

. . . Copying or moving files and folders
To prepare for a copy or move operation:
1 Navigate through the left side of the target window to
display the folder where you want to put the selections.
Click the folder. (For more information, see page 78.)
2 In the source window, select the items you intend to transfer.
Make sure that the source and the target are still showing.
(For more information, see page 80.)
NOTE Before attempting to transfer between computers,
open a File Transfer window for each of them.
To copy or move using drag and drop:
1 Place the mouse pointer over a single item or one of
several items you have selected on the source.
2 Do either of the following:
• To copy, press CTRL and your left mouse button as
you move the pointer over to the target folder.
• To move, press SHIFT and your left mouse button as
you move the pointer over to the target folder.
3 Once the target is highlighted, release the mouse button
and the CTRL or SHIFT key.
You now see the File Copy or File Move dialog box, as
shown on the previous page.

You now see the File Copy or File Move dialog box, as
described next.
NOTE Copy and Move also appear as buttons on the toolbar near the top of each File Transfer window.
To complete the copy or move:
1 In the File Copy or File Move dialog box, you can verify
the source and the target, change the target, and set
options. Do any of the following:
• Under To, verify the target. You can choose a different computer from the Computer list; in the Folder
box, you can type any drive and folder already on the
target.
• Under Options, check or clear the boxes as you
wish. For more information, see page 84.
2 Click OK to complete the operation or Cancel to halt it.
You now see a dialog box reporting on the operation as it
proceeds. Click Cancel to halt the operation. If the Protected Files dialog box appears, select the files you want
to transfer, and click OK.
TIP Dropping onto a drive puts the selections at the highest level of the hierarchy of folders.

To copy or move using a command:

TIP Dropping onto a folder puts the selections inside the
folder.

• With the source window still active, click Copy or Move
on the File menu.

TIP Dropping onto a file puts the selections on the same
level as the file.
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Setting File Transfer options for the results you want

C

ertain File Transfer options play a crucial role when you are copying or moving files. Depending on
how you set them, you can include or exclude subfolders, prevent the overwriting of files except by newer
copies, or copy only files you have backed up before. To specify global preferences for these options, click
File Transfer Options on the Options menu; then click the Filter tab. Whenever you confirm a copy or
move operation, you can change the settings for that operation.
Set global options on the Filter tab of File
Transfer Options.
When copying or moving, verify the settings
before clicking OK to continue.

There are three File Transfer options that determine which
files are transferred and which are overwritten:

• Include Subfolders in Copies

• Transfer Only If Files Are Newer

The first two options are in effect until you change them.
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• Transfer Only If Files Are Already on Target

. . . Setting File Transfer options for the results you want
To change your global preferences for File Transfer
options:
• On the Options menu, click File Transfer Options. Click
the Filter tab, and then check the appropriate boxes.
When you transfer files, you can tailor these options for that
operation before giving your confirmation.
NOTE Before transferring files between computers,
ensure that their clocks are reasonably in sync. If they are
not, files that appear to be older may actually be newer,
and you could lose your most recent work.

Protecting newer copies of files
One of the options—Transfer Only If Files Are Newer—is
designed to preserve files that represent your most recent
work. It is also useful for speeding up file transfers; files that
do not need to be updated are excluded from the operation.
When the box is checked, Transfer Only If Files Are Newer
ensures that files are not overwritten by older copies of
those files. (Files not already on the target will be copied
anyway.) When the box is cleared, files are overwritten without regard to their dates and times.

Including or excluding subfolders
One of the options—Include Subfolders in Copies—is
designed for copying a hierarchy of folders and subfolders
and is potentially the most powerful of the File Transfer
options. It can make the difference between copying hundreds of files or only a few.

folders you have selected. When the box is cleared, your
selection is limited to the selected files and folders (including
the files in those folders); subfolders within folders are
excluded.

Updating older copies of files
One of the options—Transfer Only If Files Are Already on
Target—simplifies the task of updating older copies of files
without adding new ones. It is designed for anyone who regularly updates the same set of files. No matter how many
files you select on the source, only those already on the target will be copied; the others will be ignored.
In preparation for using this option the first time, copy the
files to the target with the box cleared. When you are ready
to update the same files, check the box.

Deleting to the Recycle Bin
By default, any files you delete from a hard drive are “recycled,” that is, moved to the Windows Recycle Bin, where
you can retrieve them later.
NOTE Whether files are recycled or permanently removed
is determined solely by the setting on the computer that
opens the connection.
To permanently remove files when you delete them in
LapLink:
1 On the Options menu, click File Transfer Options.
2 On the Delete tab, clear this box: Move Deleted Files and
Folders to the Recycle Bin.

When the box is checked, Include Subfolders in Copies
extends your selection to include any subfolders within the
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Synchronizing folders with SmartXchange

U

se SmartXchange to synchronize two folders in a two-way exchange of files. You can limit the scope
of the operation by including only the files already in both folders. You can also use SmartXchange to
update a backup folder quickly. In either case, older files are overwritten, but no files are deleted.
In SmartXchange
Files are copied when they are in
one folder but not the other.

Files are overwritten when there are
newer copies in the other folder.

Files are not copied when there are
identical copies in both folders.

After SmartXchange, the two folders
are identical.

Synchronizing folders
If you have ever copied files back and forth between computers so that they share the latest files, you have synchronized. Unlike the usual copy operation, synchronization
works in two directions: from one folder to the other and
back again.
NOTE With SmartXchange, you determine the items to be
copied by selecting the folder containing the items, not by
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selecting the items themselves. Select the folder on the left
side of a File Transfer window.
With SmartXchange, you can accomplish this in one operation, one folder at a time. You can increase the scope of the
operation by including subfolders within the folder. You can
limit its scope by exchanging only the files that are on both
folders already.

. . . Synchronizing folders with SmartXchange
CAUTION SmartXchange is a tool for exchanging files
between folders. It does not merge the contents of files. If
you need to merge databases, schedules, or other shared
files, see the documentation for the program in which they
were created.

Already on Target. If you want the two folders to be
identical, the box must be cleared.
4 Make sure that this box is cleared: One-way Transfer Only.
5 Click OK.

TIP If you synchronize the same folders on a routine
basis, consider using Xchange Agent instead of SmartXchange. Xchange Agent automates the process of opening connections, selecting the pairs of folders to be
synchronized, setting the appropriate options, initiating the
exchange, and disconnecting. For more information, see
page 96.

Updating backup folders

To use SmartXchange to synchronize folders:

2 On the left side of the source window, click the folder containing the files you want to back up again.

1 On the left side of each File Transfer window, click the
folder (not an entire drive) containing the files you want
to exchange.
NOTE To verify which folder is open, look at the title bar, at
the top of the File Transfer window.
2 On the SyncTools menu, click SmartXchange. Or click the
Sync button on the toolbar near the top of the File Transfer
window.
3 Verify that the source and target are correct. If necessary,
change the target.
• If you want to include subfolders in the exchange,
check this box: Include Subfolders.
• If you merely want to update files—and not add new
ones—check this box: Transfer Only If Files Are

You can also use SmartXchange to simplify the process of
updating a folder to which you have backed up a set of files.
To use SmartXchange to update a backup folder:
1 On the left side of the target (backup) window, click the
folder you want to update.

3 On the SyncTools menu, click SmartXchange.
4 Verify that the source and target are correct. Change the target if necessary.
• If you want to include subfolders in the exchange,
check this box: Include Subfolders.
• If you want to update files—and not add new ones—
check this box: Transfer Only If Files Are Already on
Target. If you want the folders to be identical, the box
must be cleared.
5 Make sure that this box is checked: One-way Transfer Only.
6 Click OK.

87

Replacing one folder with another: Clone Folder

C

lone Folder replicates one folder onto another by adding, deleting, and updating files on the target until
they match those on the source. After opening the target and the source folders, click Clone Folder on the
SyncTools menu. Then choose whether to include or exclude subfolders.

Source

Target
Use Clone Folder to replace the contents of one folder (the target) with
the contents of another (the source).
Clone Folder has the effect of erasing the target and copying the entire
source.

Clone Folder replaces one folder (the target) with another
(the source). The effect is the same as deleting everything
on the target and copying everything from the source.
Cloning a folder adds and updates target files until they are
identical to those on the source. In addition, it deletes any
target file that has no counterpart on the source.
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NOTE With Clone Folder, you determine the items to be
copied by selecting the folder containing the items, not by
selecting the items themselves.

. . . Replacing one folder with another: Clone Folder
It’s the deletion of files that makes Clone Folder useful, particularly when you are maintaining a backup folder. With the
usual copy operation, the backup folder over time accumulates all the files you have deleted from the source. With
Clone Folder, those unwanted files are removed with each
backup.
CAUTION Use this command with caution. Any subfolder
or file not on the source will be deleted from the target.
To replace one folder with another:
1 On the left side of the target window, click the folder
whose contents you want to replace.

2 On the left side of the source window, click the folder whose
contents you want to reproduce.
3 With the source window still active, click Clone Folder on the
SyncTools menu.
4 Verify that the source and target are correct. Change the target if necessary.
5 If you want to reproduce subfolders within the selected
folder, check this box: Include Subfolders.
6 Click OK.
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Speeding file transfers with SpeedSync and compression

W

hen you are updating files, SpeedSync can shorten transfer times by sending only the parts of the
files that have changed since the last update. SpeedSync is most effective when you update files that
have not been changed extensively since the last update. Compression, on the other hand, speeds file
transfers by “shrinking” files before they are sent and restoring them to their original sizes afterward.
Compression is most effective with large files that have not been compressed already. Though both
features are in effect by default, there may be circumstances in which you might improve transfer times by
disabling them.
With SpeedSync
Source and target files are compared
to locate changes in the source file.
Only the changes are copied, usually
resulting in faster transfers.

Without SpeedSync
Source and target files are not compared for changes.
Entire files are copied, often resulting
in longer transfer times.

Using SpeedSync
SpeedSync is designed to cut transfer times when you are
updating files. It has no effect when you are copying files
that were not on the target before you started copying.
Before a file is copied, SpeedSync searches the target for a
file with the same name. If none is found, the entire file is
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copied. Otherwise, the two files are compared to locate
changes in the source file. Only the changes located in the
source file are copied.
The time necessary to locate changes is usually more than
offset by the smaller amount of data that has to be transferred. The reverse may be true in a few circumstances,

. . . Speeding file transfers with SpeedSync and compression
particularly when you are updating files over a fast network
connection.
NOTE Whether SpeedSync and compression are used in
file transfers depends entirely on the settings of the guest
(the computer that opens the connection).
CAUTION SpeedSync is a tool for decreasing transfer
times. It does not merge the contents of two files. The contents of one file will always replace the contents of the
other. If you need to merge databases, schedules, or other
shared files, see the documentation for the program in
which they were created.
To disable SpeedSync:
1 On the Options menu, click File Transfer Options.
2 On the Performance tab, clear this box: Use SpeedSync on
All File Transfers.

click SpeedSync Statistics on the SyncTools menu. You
see the statistics for your most recent transfer as well as
combined statistics for earlier transfers.

Using compression
Because compression usually results in the transfer of less
data, it is particularly useful when you transfer large files by
modem: the larger the files, the greater the savings.
Since compression would actually slow the transfer of files
that have already been compressed (by PKZIP or another
file-compression program), LapLink automatically turns this
feature off while it is transferring such files.
If you find a situation in which compression does not speed
up file transfer, you can disable it: On the Options menu,
click File Transfer Options. On the Performance tab, clear
this box: Use Compression When Transferring Files.

TIP To review the effect of SpeedSync on your past file
transfers, open at least one File Transfer window. Then
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Resuming an interrupted file transfer

I

f you lose your connection to another computer while transferring files, File Transfer Recovery lets you
connect again and continue the transfer where it left off. Any file—or portion of a file—copied before the
interruption is skipped; only the untransmitted data is copied.
If you lose a connection while
transferring a file, the data
transferred at the point of interruption is stored on the target
computer.

When you reconnect and
resume the transfer, the missing part of the file—not the
entire file—is copied, along with
the remaining files.

File Transfer Recovery lets you continue a file transfer even
when you have lost a connection. Instead of starting the
transfer at the beginning, File Transfer Recovery resumes
at the point where the connection was lost:
• Only the missing part of the interrupted file is copied.
• Files successfully copied before the interruption are not
copied again.
TIP File Transfer Recovery is particularly useful when
you copy large files over an unreliable modem connection.
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To resume an interrupted file transfer:
• If you were running an Xchange Agent when the interruption occurred, run the agent again.
• If you were transferring from File Transfer windows:
1 Re-establish the connection.
2 Select the same files and folders.
3 Begin the transfer again.

. . . Resuming an interrupted file transfer
File Transfer Recovery and other options
Three options must be enabled for File Transfer Recovery
to work effectively. All three appear in File Transfer Options
(Options menu) and are enabled by default.
Enable File Transfer Recovery Located on the Copy/
Move tab, this box must be checked for File Transfer
Recovery to occur at all.
Use SpeedSync on All File Transfers Located on the
Performance tab, this box must be checked to allow the
transfer to resume with the missing part of a file. When it is
cleared, the entire file must be sent again.

Transfer Only If Files Are Newer Located on the Filter
tab, this box must be checked so that files successfully copied before the interruption are not copied again.
When a transfer is interrupted, File Transfer Recovery creates a file in the target folder containing whatever part of the
file has been transferred successfully. The file is named
!LAPLINK.TSI.
When File Transfer Recovery resumes a transfer, this file is
compared with the source file to determine what’s missing.
Once the file is complete, !LAPLINK.TSI is given its original
name. (If you do not use File Transfer Recovery to resume
the transfer, the file remains in the folder and can be
deleted.)
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Using Xchange Agent—Overview

X

change Agent automates synchronization—the process of keeping your files updated when you use
two computers. To set up an Xchange Agent, open a connection to another computer, choose the pairs of
folders to be synchronized; then preview and perform the synchronization. After working on the files on
either or both of the computers, run the agent to reconnect and update the older copies of the files
automatically. You can run an agent by double-clicking its shortcut icon or by scheduling it to run
unattended.
In the end, files in the synchronized
folders are identical.

Xchange Agent automatically copies the newer versions of all
files regardless of which computer they are on. Files that have
no match are copied onto the computer that lacks them.

Xchange Agent simplifies the repetitive process of keeping
two computers—often a laptop and a desktop—in sync.
Whether your most recent work appears on one or both of
the computers, Xchange Agent transfers files so that both
have only the newer copies of your files.
Xchange Agent automates the process of opening connections, selecting the pairs of folders to be synchronized, set96

ting the appropriate options, initiating the exchange, and
disconnecting. To prevent unwanted results, you can preview beforehand.
NOTE Xchange Agent is also useful for local synchronizations, as when you keep files on your desktop in sync with
files on a local network.

. . . Using Xchange Agent—Overview
Creating an Xchange Agent
Open a LapLink connection—by modem, network, or any
other means—to the computer with which you want to
exchange files.

TIP By default, agents are previewed before being run.
To bypass preview, click Properties on the File menu and
click an option on the Run Options tab. For more information see page 105.

Then use the Xchange Agent wizard to create your own
Xchange Agent:

Running an Xchange Agent

• From the hierarchy of folders displayed for each computer, choose the pair of folders—one folder on each
computer—you want to synchronize. Choose as many
pairs as you want.

• Double-click its shortcut icon on the desktop.

• Name your Xchange Agent file and save it.

• Double-click the agent file in Windows Explorer.

• Preview the agent you just created, making sure that
you set it up as intended.

CAUTION Xchange Agent exchanges files between folders. It does not merge the contents of files. To merge databases and other shared files, use the program in which the
files were created.

Then run the agent to make the files in each pair of folders
identical.
NOTE Xchange Agent automatically copies the newer
versions of all the files regardless of which computer they
are on. Files that have no match are copied onto the computer that lacks them.

Previewing an Xchange Agent
To prevent unintended consequences, you can preview an
agent before synchronizing. The preview screen shows
pairs of folders and files, with arrows to indicate the direction
in which files will be copied when the agent is run.
In a preview, you can customize the agent by excluding
pairs of files (and entire folders) from the current synchronization, leaving the files as they are on each computer.

There are several ways to run an Xchange Agent:
• Schedule the agent to run unattended.
• Start LapLink and run the agent.

Beyond the basics
Xchange Agent offers various options for customizing each
synchronization. For example, you can:
• Change the direction of copy: instead of a two-way
exchange of files, copy files in one direction only, from
one computer to the other.
• Include or exclude (filter) files according to type or
name.
• Include or exclude subfolders within synchronized folders.
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Creating an Xchange Agent

O

nce you connect to another computer, you create an Xchange Agent by selecting the pairs of
folders—one folder on each computer—which you want to keep synchronized. You can select the pairs
from a window displaying the folders on both computers, or you can drag folders from File Transfer
windows onto the Xchange Agent window. In either case, you can preview the agent to ensure that you
have set up the synchronizations as intended.

To create an Xchange Agent:
1 Start LapLink and open a connection with the computer
with which you want to synchronize files.
For a local synchronization, simply start LapLink.
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2 On the SyncTools menu, click either of these:
• Xchange Agent wizard
• New Xchange Agent

. . . Creating an Xchange Agent
Using the Xchange Agent wizard
The wizard guides you through the process of selecting
pairs of folders to be synchronized. After naming and saving
the agent file, you can preview the agent and change its settings.
To make the files in each folder pair identical, click the Run
button on the toolbar.
NOTE There are two “modes” in Xchange Agent: edit and
preview. Certain operations are available in one mode and
not the other. To save an agent, for example, you must be
in edit mode. To change to edit mode from preview mode,
click the Close Preview button on the toolbar.

Using New Xchange Agent
After choosing New Xchange Agent from the SyncTools
menu, you can select the pairs of folders to be synchronized
in two ways:
• On the Edit menu, click Add Folder Pair. After specifying whether the synchronization is Local-Local or Local-

Remote, click a folder on each side of the window.
Repeat the procedure to add other folder pairs.
• Drag folders from File Transfer windows onto the
Xchange Agent window. Drag a folder first from one File
Transfer window, then from the other one. Repeat the
procedure to add other folder pairs.
Once you have selected the pairs to be synchronized, you
can do any of the following:
• Preview the agent: click the Preview button on the toolbar.
• Name and save the agent file: On the File menu, click
Save. In the File Name box, type a name, and click OK.
• Run the agent to make the files in each folder pair identical: click the Run button on the toolbar.
TIP Xchange Agent files are given the .LLX extension. In
Windows 95 and Windows 98, they are stored in the My
Documents folder. In Windows NT, they are stored in the
\Profiles\yourname\Personal folder within the Windows
folder (where yourname is your Windows NT logon name).
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Previewing and running an Xchange Agent

P

reviewing an Xchange Agent lets you see exactly which folders will be synchronized and which files
will be overwritten. It also lets you skip pairs of folders and files and resolve conflicts. Unless you specify
otherwise, you preview each agent before you run it. You can run an agent from the Windows desktop,
from within LapLink, or you can schedule it to run in your absence.

While previewing an Xchange Agent, you can
tell the direction of copy from the arrows.

A special icon appears when both files have been modified since a
previous synchronization. You can specify how these “conflicts” are
handled.

Previewing
By default, a preview appears whenever you run Xchange
Agents. You can also open an agent and preview it.
NOTE By default, only agents that you schedule to run
unattended will proceed without a preview. To set up other
agents to run without a preview, see page 105.
To open and preview an Xchange Agent:
1 In LapLink, click Open Xchange Agent on the SyncTools menu. (In Xchange Agent, click Open Xchange
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Agent on the File menu.) Then click the agent file and
click Open.
2 Click the Preview button on the toolbar.
While previewing an agent you can do any of the following:
• Select files or folders to be omitted from the current
synchronization only Click a pair and click the Skip
Pair button on the toolbar. Skipping a folder skips all the
files and subfolders it contains.

. . . Previewing and running an Xchange Agent
• Put skipped pairs back into a
synchronization Click a skipped pair and then click
the Undo Skip button on the toolbar.
• Resolve conflicts Click a pair showing a conflict icon,
click the Resolve Conflict button on the toolbar, and
specify how you want the conflict resolved. For more
information about resolving conflicts, see page 102.
NOTE In a preview, arrows indicate the direction in which
files will be copied, and thus which files will be overwritten.
Special icons indicate conflicts between files.

TIP While in edit mode you can customize an agent in
several ways. For more information see page 104.

Running an Xchange Agent
There are several ways to run an Xchange Agent:
• Double-click the agent’s shortcut icon on the desktop.
To create a shortcut icon for an open agent, click Create
Desktop Shortcut on the File menu.
• Schedule the agent to run at an appointed time. For
more information see page 108.

CAUTION Once you have resolved conflicts or marked
pairs to be skipped, run the agent before closing the preview. Your modifications will be lost otherwise.

• Run the agent from within LapLink: Click Run Xchange
Agent on the SyncTools menu. Then click the name of
the agent file and click Open.

TIP To select every pair of folders and files in the agent,
click Select All on the Edit menu.

• Run an agent you have opened in Xchange Agent: click
the Run button on the toolbar.

TIP To locate a pair with a conflict, click the Next Conflict
button on the toolbar.

• In Windows Explorer, double-click the agent file.

To close a preview:
• Click the Close Preview button on the toolbar. You are
now in edit mode.

Once an agent finishes synchronizing files, the connection
with the remote computer is closed. If LapLink was not running to begin with, it is shut down automatically.
NOTE For a record of your latest synchronizations, refer to
the LapLink log file: on the Options menu, click Logging.
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Dealing with conflicts

W
hen you are keeping folders on two computers in sync, the most common kind of conflict occurs
when a file has been modified on both computers since the last time you synchronized. You can handle
these conflicts when you preview or run the agent. Or you can set options to handle them automatically.

Conflicts between files
Conflicts occur when you modify a file on both of your computers. Since both files are new, you need to decide how to
handle them. These are the choices you can make while
previewing or running an Xchange Agent:
• Copy either the older or the newer file to the other
folder, replacing the file already in that folder.
• Copy either the older or the newer file to the other folder
and give the file a new name. Nothing is replaced.
• Skip the conflict, without copying either file.
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When you skip a conflict, you carry it over to future synchronizations. There are now two categories of conflicts:
• New conflicts Files have been changed on both
computers since the previous synchronization.
• Old conflicts Conflicts were left unresolved in earlier
synchronizations. The two computers now have different versions of the same file, and both are dated prior to
the latest synchronization. You can treat these conflicts
like new conflicts, or ignore them and let both versions
remain.

. . . Dealing with conflicts
Changing how all conflicts are handled By default,
each conflict is presented for resolution when you run an
Xchange Agent. You can change this so that conflicts are
handled automatically.

2 On the File menu, click Properties.

To change how conflicts are handled by an Xchange
Agent:

Other conflicts

1 Open the Xchange Agent.
2 On the File menu, click Properties.
3 On the Run Options tab, click this option: Run Unattended,
without Preview or Confirmations. Then click either of these
options:
• Do Not Copy Either; Keep Both Files
• Copy the Newer File over the Older
Ignoring old conflicts By default, old and new conflicts
are treated alike, according to the settings on the Run
Options tab in Properties. For example, if you specify that
conflicts are to be displayed every time you run an agent,
old conflicts will appear every time you run the agent. The
alternative is to exclude old conflicts, regardless of how
other conflicts are handled.
NOTE To retain both versions of files in old conflicts, click
this option on the Advanced tab in Properties: Exclude
Previously Skipped Files.
To exclude old conflicts from synchronizations:
1 Open the Xchange Agent.

3 On the Advanced tab, click this option: Exclude Previously
Skipped Files.

You may encounter other kinds of conflicts in these situations:
• When you attempt to copy a file or folder with a long
name to a drive that does not accept long names.
• When you attempt to synchronize a file with a folder;
this happens only when a file and a folder have exactly
the same name.
Long name conflicts If you do not shorten long names,
you are given this choice when you run an agent: copy the
file and give the copy a short name, or skip the conflict without copying the file.
Conflicts between files and folders If you do not
rename the file to avoid the conflict, you are given this
choice when you run an agent: copy both the file and folder
and give the copies new names, or skip the conflict without
copying either.
The best way to handle either of these conflicts is to rename
files: shorten the long names or rename the file so that it
does not conflict with the name of the folder. True synchronization cannot occur otherwise. If you set an agent to run
unattended, for example, neither file in a conflict is copied.
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Customizing an Xchange Agent

Icopied
nstead of a two-way synchronization, you can customize an agent so that files within folder pairs are
in one direction only, from one computer to the other. Among other modifications, you can create a
shortcut icon to run an agent directly from the desktop, run an agent without a preview, and limit
synchronizations just to the files that already appear on both computers.

To change the direction of the copy, click one
or more of the folders.
Then click either the left or right arrow button to
specify the direction.

To customize an agent, you must open it from within
LapLink or Xchange Agent.
To open an agent:
• In LapLink, click Open Xchange Agent on the SyncTools menu. Click the agent file and then click Open.
• In Xchange Agent, click Open Xchange Agent on the
File menu. Click the agent file and then click Open.

Changing the direction of copy
When you create an Xchange Agent, all folder pairs are set
for a two-way exchange of files. Files are copied in both
directions, until the folders on both computers are identical.
You can modify this by specifying that files in a folder pair be
copied in one direction only, so that only one folder updates
the other.
NOTE To customize an agent, you must be in edit mode. If
you are previewing, click the Close Preview button on the
toolbar.
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. . . Customizing an Xchange Agent
To change the direction in which files are copied in a
folder pair:
1 Click the folder pair.
To change the direction of copy for all folder pairs, click
Select All on the Edit menu.
2 Click an arrow button on the toolbar to change the direction
of the copy.

Adding folder pairs
To add a pair of folders to an Xchange Agent:
1 Open a connection with the computer with which you
are synchronizing.
2 On the Edit menu, click Add Folder Pair.
3 Click one folder for each computer and then click OK.
NOTE To delete a pair of folders, click the pair and click
Delete Pair(s) on the Edit menu. Then click Yes. The folders are deleted from the agent, not from the computers.

Changing how an Xchange Agent is run
There are several ways to customize how an agent is run:
• Create a shortcut icon for running an agent from the
desktop: on the File menu, click Create Desktop Shortcut.
• Schedule the agent to run at the time you want: on the
File menu, click Schedule. For more information see
page 108.

• Set up the agent to run unattended: On the File menu,
click Properties. On the Run Options tab, click this
option: Run Unattended, without Preview or Confirmations. Then determine how conflicts will be handled by
clicking either of these options: Copy the Newer File
over the Older or Do Not Copy Either; Keep Both Files.

Changing which files are included in
synchronizations
By default, subfolders within folder pairs are included in synchronizations. Read-only files are also included, but hidden
files and system files are not. To change these settings, click
Properties on the File menu. Then click the File Options tab
and change the settings as necessary.
Also on the File Options tab, you can set an option to limit
synchronizations by exchanging only files that already
appear on both computers. To exclude files that have been
added to one computer and not the other, check this box:
Include Files Only If They Are Present in Both Folders.
NOTE Filters offer another way of determining which files
are included in synchronizations. For more information,
see page 106.
TIP Instead of changing the various options every time
you create a new agent, you can set default options to
apply to any agents you create in the future. These
defaults will take effect in new agents unless you specify
otherwise in Properties. To change the defaults, click Properties for New Agents on the Options menu.
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Using filters to include or exclude files

U

sing preset filters or filters you create yourself, you can limit synchronizations by including only certain
files or types of files. Or you can use the same filters to exclude files and file types.

Click a filter in the list of
available filters. Then
click the Add button.

By default, filters limit synchronization to files that
match the filters.
If you prefer, you can use
filters to exclude matching
files—and synchronize the
rest.

Xchange Agent is shipped with filters for some of the most
common types of files, including Microsoft Word, Lotus 1-23, and dBase. File types are defined by one or more extensions. Word files, for example, are defined by the extensions .DOC and .DOT.

To filter files by type using the preset filters:

You can also create your own filters for different file types—
or for specific files.

2 In the list of available filters, click a filter and then click the
Add button. Repeat the process to add other filters.

You can use filters to synchronize only the files matching the
filters. Or you can exclude the files matching the filters and
synchronize the rest of the files.

3 To use the filters to exclude—not include—file types, check
this box: Exclude Files That Match These Filters.
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1 Click a folder pair, and then click Set Filter on the Edit
menu.
To filter all folder pairs, click Select All on the Edit menu.

4 Click OK.

. . . Using filters to include or exclude files
To create and apply your own filter:

To remove the effects of a filter:

1 Click a folder pair and then click Set Filter on the Edit
menu.

1 Click the filter in the list of active filters.

2 Under the list of available filters, click the New button.
3 In the Filter Name box, type a description for the filter.
4 In the Pattern(s) box, type one or more file extensions or file
names, using a semicolon (;) to separate them.
To specify file types, use extensions preceded by asterisks: *.chp;*.sty and so on. To specify certain files,
type their entire names:
annual.xls;march.xls;april.xls and so on.
5 Click OK.
Your filter now appears in the list of available filters.
6 Click the filter and then click the Add button.
7 To use the filters to exclude—not include—file types, check
this box: Exclude Files That Match These Filters.

2 Click the Remove button.

Modifying a filter
You can modify any of the filters appearing in the list of
available filters. To apply the modifications, you must add
the filter to the list of active filters, even if the filter already
appears in that list.
To edit and apply a filter:
1 Click the filter in the list of available filters.
2 Click the Edit button.
3 Change the Filter Name or Pattern(s) as necessary and
then click OK.
4 In the list of available filters, click the filter then click the Add
button.
TIP To delete an available filter, click it and then click the
Delete button.
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Scheduling an Xchange Agent to run automatically

Y
ou can schedule an Xchange Agent to run at a certain time on the days you specify. Scheduled agents
run unattended: there is no preview, and conflicts are handled automatically. To schedule an agent, open
it from within LapLink or Xchange Agent. To run the agent on schedule, simply leave your scheduler
running.

You can schedule an
Xchange Agent to run
unattended.
When the scheduled
time comes, LapLink
starts, the connection is
opened, files are synchronized, the connection is closed, and
LapLink shuts down.

You can set up an Xchange Agent to run at a particular time
on one of these schedules:

• On certain days of the week (such as Monday and Friday)

• Just once, on a particular date (such as June 27, 2000)

• Once a month on a particular day (such as the first day
of each month)

• Every day
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. . . Scheduling an Xchange Agent to run automatically
LapLink does not have to be running for an agent to run as
scheduled. When the scheduled time comes, LapLink
starts, the connection is opened, files are synchronized, the
connection is closed, and LapLink shuts down.
LapLink prepares an Xchange Agent to run on schedule by
setting it up in a scheduler program running in Windows. If
you have either of the following scheduler programs, it is
used to run scheduled Xchange Agents:
• The System Agent program included in the Microsoft
Plus! Companion for Windows 95
• The Task Scheduler program included in Windows 98
and Microsoft Internet Explorer 4.0
Otherwise, the LapLink Scheduler program (installed with
LapLink) is used. The LapLink Scheduler icon appears at
the right end of the Windows taskbar.
NOTE Xchange Agents can’t be scheduled using the Task
Scheduler in Windows NT 4.0.
To schedule an Xchange Agent:
1 From within LapLink or Xchange Agent, open the agent.
2 On the File menu, click Schedule.
The Schedule wizard begins.
3 Give a name to the schedule file.
4 Fill out the schedule by specifying the time and frequency.

TIP Once you have scheduled an Xchange Agent in
LapLink, you should modify it in your scheduler program,
not in LapLink.
TIP To create another schedule for the same agent
repeat the above procedure and assign a different name
to the schedule file.
To run a scheduled agent:
• Leave your Windows operating system and your
scheduler running.

Running an agent unattended
A scheduled agent runs without preview, even if you have
specified preview on the Run Options tab of Properties.
When conflicts are encountered, they are ignored; neither
file is copied. If you prefer to have the newer file in each
conflict copied over the older one, click Properties on the
File menu. On the Run Options tab, click this option: Run
Unattended, without Preview or Confirmations. Then click
this option: Copy the Newer File over the Older.1
TIP To ensure that an agent runs and synchronizes as
scheduled, create an entry in Address Book. Include the
log-in name and password required by the remote computer to open the connection.
1 For more information about resolving conflicts, see page
102.
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7 Using Print
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Using Print Redirection—Overview
Printing over a LapLink connection
Setting up printers for Print Redirection

Using Print Redirection—Overview

T

here are two ways to print over a LapLink connection. While controlling a remote computer, print from
that computer directly to your local printer. Or reverse direction and print directly from your local computer
to a remote printer. Either way, you use Print Redirection to send a document over LapLink to be printed
at the opposite end of the connection.
Once you have opened a LapLink connection, you can use
Print Redirection to send a document from the computer at
either end of the connection to a printer at the other end.
There are two ways to use Print Redirection over a LapLink
connection:
• Print from remote to local While using Remote Control to view and operate another computer, you can
send a document from that computer to a printer at your
location. For example, you can prepare a document on
your office computer from home and print the document
on your home printer.
• Print from local to remote When connected to
another LapLink computer, you can print a document
from your computer to a printer at the remote location.
For example, after working on a report at home or on
the road, you can connect to your office computer and
print the report to a high-quality laser printer in your
office.
Without Print Redirection, you’d have to transfer the document to the other computer and then use Remote Control to run a program on the remote computer and print
the document.
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Printing a document over a LapLink connection is much like
printing it on a local printer: In the program in which you
have prepared the document, choose the standard Print
command. Normally you would then choose a printer close
at hand. In Print Redirection, however, you choose a printer
at the opposite end of the connection from the document.1
When printing from remote to local, use Remote Control to
choose Print on the remote computer; then choose a printer
attached to your local computer.
When printing from local to remote, choose Print on your
local computer; then choose a printer attached to the computer at the other end of the LapLink connection.

Preparing for Print Redirection
To print documents from a computer to a printer at the other
end of a LapLink connection, you need to set up the destination printer on that computer. If you want to print reports
on the office printer while at home, for example, set up the
office printer on your home computer.2
1 For detailed instructions on printing over a LapLink connection, see page 114.
2 For detailed instructions on setting up a printer for Print
Redirection, see page 116.

. . . Using Print Redirection—Overview
You can set up a printer for Print Redirection during LapLink
Setup or afterward, using Print Redirection options in
LapLink.

Requirements for Print Redirection
There are two requirements for using Print Redirection:
• You must connect to another version of LapLink that
supports Print Redirection.
• The default security setup on the other computer must
be changed to allow Print Redirection.
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Printing over a LapLink connection

T
o print over a LapLink connection, choose the standard Print command in any Windows program and
then choose a printer set up especially to receive print jobs from remote computers. The document then
travels over the LapLink connection to a printer at the other end.
Print from a Windows
program as you normally
would, using the Print
command.

Then choose the
printer you set up
for Print Redirection.

Printing over a LapLink connection is much like printing to a
local printer. You simply choose a different printer—one that
has been installed especially to print over LapLink.
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When printing from remote to local, choose a local printer
from the remote computer using Remote Control. When
printing from local to remote, choose a remote printer from
the local computer.

. . . Printing over a LapLink connection
To print a document over a LapLink connection:

Choosing among several printers

1 Open a LapLink connection to the remote computer.

Normally, Print Redirection sends documents to the printer
that has been set up as the default printer on the connected
computer. If you send a print job from home to the office, for
example, the printer designated as the default on the office
computer automatically gets the job. (If there is only one
printer set up on a computer, that printer is always used.)

• To print from remote to local, include Remote Control
in the services you open.
• To print from local to remote, open Print Redirection
or any of the other services.
2 Open a word processor, spreadsheet, or other program and
prepare the document for printing.
3 Use the standard Print command for your program and
choose the printer you set up just for Print Redirection. (It is
typically a printer with [LapLink] at the end of its name.)
The Print Redirection icon on the LapLink status bar animates as the document is sent over a LapLink connection
to the destination printer.
When the animation stops, the document has arrived at the
other computer. You can then close LapLink if you want.
TIP You can monitor the status of the printing document
after it’s been sent over a LapLink connection. On the
computer to which the printer is attached, click the Windows Start button, point to Settings, and click Printers.
Then double-click the printer icon.

If you want to use a printer other than the default, you need
to set up LapLink to prompt you with a list of available printers whenever you print. Change this setting on the computer the printers are attached to, not the computer with the
document.
TIP If you’re not in front of that computer, you can still
change this setting by remote controlling the computer.
To set up LapLink to prompt with a list of printers:
1 On the computer the printers are attached to, click Print
Redirection Options on the Options menu.
2 Click Prompt with a List of Available Printers.
Whenever you send a document to that computer to be
printed, you are prompted with a list of all the printers set up
on that computer.

NOTE You can use Print Redirection over a LapLink connection even when it is not one of the services currently
open. Print Redirection becomes available on demand.
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Setting up printers for Print Redirection

T
o print documents from a computer to a printer at the other end of a LapLink connection, you need to
set up the destination printer on that computer. If you do not set it up while installing LapLink, you can set it
up using the Print Redirection Options in LapLink. For best results set up a printer identical to the one you
will be printing to, at the other end of the connection.
To set up a new printer, click the Setup button in the Print
Redirection Options dialog box.

Before you can use Print Redirection, you need to add a
printer for Print Redirection to the computer you’ll be printing
from (the location where your documents are kept).
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Choose the printer from the list.
If your printer arrived with a setup disk,
click Have Disk.

For example, if you’re remote controlling your office computer and want to print a document on that computer to your
printer at home, you need to set up your home printer on the
office computer.

. . . Setting up printers for Print Redirection
If you want to print a document on your home computer to a
high-quality printer at your office, you need to set up that
printer on your home computer.
The printer you set up for Print Redirection should match
the printer you’ll be printing to at the other end of the connection. Although it is possible to use a compatible printer,
the results you get when printing might not be as good.

Setting up a printer
You can set up a printer during LapLink Setup or from within
LapLink after installation. You will probably need your Windows CD-ROM or the disk that accompanied your printer.

To set up a printer from within LapLink:
1 On the Options menu, click Print Redirection Options.
2 Click the Setup button to start the Print Redirection Setup
wizard.
3 Follow the instructions in the wizard.
Once the printer is set up, you can print to it, and your document is sent over your LapLink connection. In order to print,
LapLink must be running and connected to the computer
you want to print to.
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Exchanging typed messages using Text Chat

T
ext Chat lets you exchange typed messages with a person sitting at a remote computer. Used with a
service like Remote Control or File Transfer or by itself, Text Chat is useful for exchanging brief messages
and sending instructions. However, if you have a microphone, sound card, and speakers, you can use
Voice Chat instead.

Read messages sent from the
remote computer—as well as
your own—in the upper part of
the Text Chat window.

Type your messages in the lower
part. Press ENTER to send.

Opening a Text Chat window
When you connected to the remote computer, you may
have opened a Text Chat window. If not, you can open one
after you open the connection.

TIP If you have opened more than one connection, click
a window for the desired connection before opening Text
Chat.

Sending messages

To open a Text Chat window:

A Text Chat window is divided into two parts:

• Click the Open Text Chat button on the Shortcut bar. Or
click Open Text Chat on the Window menu.

• The upper part displays the messages you have sent to
the remote user as well as those the remote user has
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. . . Exchanging typed messages using Text Chat
sent to you. Each message is identified by the name of
the computer from which it was sent.

2 In LapLink, click the lower part of the Text Chat window.
3 On the Edit menu, click Paste.

• The lower part serves as a note pad on which you write
your messages. It clears each time you send a message.

NOTE To reverse your latest editing action in the lower
part of a Text Chat window, click Undo on the Edit menu.

NOTE A Text Chat window pops to the foreground on your
screen whenever the remote user sends a message. To
keep the Text Chat window from activating automatically,
click Text Chat Options on the Options menu. Then clear
this option: Restore Text Chat Window Automatically.

Copying text from your Text Chat window
You can copy part or all of a Text Chat conversation and
paste it into another Windows program.
To copy your Text Chat conversation:

1 Click the Text Chat window.

1 In the upper part of the Text Chat window, highlight part
of the text, or select the entire conversation by clicking
Select All on the Edit menu.

2 Type your message.

2 On the Edit menu, click Copy.

To send a message to the remote user:

Avoid pressing ENTER until your message is complete.
To start a new paragraph, press CTRL+ENTER.
3 Press ENTER to send the message.

Pasting text into your Text Chat window
Instead of typing messages while connected, you can prepare them ahead of time and paste them into the Text Chat
window as necessary.

3 Switch to another Windows program, and paste the text into
that program.
TIP As a guest during Remote Control, you can carry on
a Text Chat conversation with the host only by viewing the
host screen in a window. (In full-screen view, you cannot
see your own Text Chat window.) To arrange the Text Chat
window beside the Remote Control window, click Tile Side
by Side on the Window menu.

To paste text into a Text Chat window:
1 In Notepad or another Windows text editor, select the
text and copy it.
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Talking to someone using Voice Chat
Voice Chat lets you speak with a person at the other end of a LapLink connection, using the same line that
transfers data between the two computers. Both computers must be configured for full duplex if you are to
talk as you would on the telephone. If either computer is configured for half duplex, you must wait for the
other person to stop talking before you begin.
How you talk to the other person
in Voice Chat depends on
whether the current conversation
is using half duplex or full duplex.

You can adjust the volume of the
speaker and microphone or mute
them entirely.

When you’re using half duplex,
watch the icon to determine when
to talk and when to listen.

Use Voice Chat to talk to someone you’re connected to over
LapLink while using other LapLink services like File Transfer
and Remote Control. To use Voice Chat, you must have a
computer that is capable of recording and playing sound.
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You may have started Voice Chat when you connected to
the remote computer. If not, you can start it after you open
the connection.

. . . Talking to someone using Voice Chat
Starting Voice Chat
To start Voice Chat:
1 Click the Open Voice Chat button on the Shortcut bar.
Or click Open Voice Chat on the Window menu.
2 The person on the other end of the connection is “called”
and asked whether he or she wants to talk with you.
If the Voice Chat connection is accepted, a Voice Chat
window opens, and you can begin talking to the other
person.
TIP If you have opened more than one connection, click
a window for the desired connection before starting Voice
Chat.

Talking in Voice Chat
To use Voice Chat, you speak into the microphone and listen through headphones or speakers. If the other person
can’t hear you very well, increase the microphone level in
the Voice Chat window. If the other person’s voice is too
loud or too soft, change the speaker level.
NOTE Although there are other volume/level controls in
Windows, it is recommended that you use the ones in
LapLink for best results.
Depending on the configuration of the sound card in both
computers, you may be able to talk as you would on a telephone; that is, your voice and the voice of the other user
can be transmitted simultaneously. This is known as full
duplex.
If you and the other user are not using full duplex, you must
talk as you would on a walkie-talkie; that is, you must wait
for the other person to finish before you begin. The transmission of just one voice at a time is known as half duplex.

Voice Chat conversations are always half duplex unless
both sound cards are configured for full duplex. The indicator at the top of the Voice Chat window shows whether your
current conversation is half duplex or full duplex.
Voice Chat provides an alternate method you can use to
talk using Voice Chat, known as Manual mode; see page
126.

Talking using half duplex
When you are having a half-duplex conversation, refer to
the stoplight icon in the lower right corner of the Voice Chat
window to know when you can talk. When the light is green
or the text says “Talk,” you can talk. When the light is red or
the text says “Don’t Talk,” you should wait until the other person has finished talking.
TIP Saying “over” when you are finished talking may help
facilitate conversation.
Notice that the stoplight icon is also available on the LapLink
status bar, so you can minimize the Voice Chat window and
continue talking.

Configuring your sound card for full duplex
Some sound cards can be reconfigured for full duplex
merely by adding new sound card driver software to your
computer. Contact your sound card manufacturer to find out
whether your sound card is capable of full duplex and to
obtain sound card driver software. Sound card drivers can
often be found on the manufacturer’s Web site.
Remember that the sound card of the person you’re talking
to also has to be configured as full duplex in order for you to
talk in full duplex.
NOTE Over slower connections, you may not be able to
use full duplex, because of the lower bandwidth of the connection.
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Improving Voice Chat performance

T
o improve Voice Chat performance, click the Levels tab in the Voice Chat Options dialog box, and then
configure the microphone and speaker levels and specify information about your environment.
Use the Levels tab of the Voice
Chat Options dialog box to configure your speaker, microphone,
and environment levels.

For the speaker and microphone
levels, click the button, and then
adjust the sliders to the desired
level.

For the environment level, click
the Setup button and follow the
instructions.

If you have already used a program that records and plays
sound in Windows, you probably do not have to change settings for your speakers and microphone before using Voice
Chat. (For exceptions, see online help.)
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However, Voice Chat lets you change settings for your
speaker, microphone, and environment to improve performance in Voice Chat. It is recommended that you do this
once, preferably before you start using Voice Chat.

. . . Improving Voice Chat performance
Setting levels in Voice Chat
The Levels tab on the Voice Chat Options dialog box lets
you perform recording and playback tests and measure
other speech qualities. Use the Levels tab when you’re not
using Voice Chat.
To configure levels in Voice Chat:
1 On the Options menu, click Voice Chat Options.
2 Click the Levels tab.
3 Under Set Speaker Level, click the Play Speech button.
TIP Some sound cards do not allow these settings to be
changed using software; in this case, the sliders won’t be
available.
4 While listening to the speech, move the Speaker Level slider
to a comfortable level.
If you cannot hear the speech, move the slider towards
High. If the speech is too loud, move the slider towards
Low.
5 Under Set Microphone Level, click the Record button. The
Windows Sound Recorder opens.
TIP If the Sound Recorder is not available, adjust this
option while you are using Voice Chat, instead.
6 Use the Sound Recorder to record and play back a few seconds of speech.

7 If you could not hear what you recorded, move the Microphone Level slider towards High, and try using the Sound
Recorder again.
8 Under Set Environment Level, click the Setup button. The
Environment Setup wizard begins, and you’re asked to
record a few seconds of background noise and a few seconds of speech.
Setting the environment level helps avoid transmitting
sound that is not speech. It is recommended that you use
the Setup button, and not the slider, to adjust this level.

Improving quality over a fast connection
Voice Chat works best over a fast connection. If you use
Voice Chat over a network or other fast connection, you
might be able to improve the Voice Chat sound quality.
To improve Voice Chat performance over a fast connection:
1 On the Options menu, click Voice Chat Options.
2 On the Advanced tab, change Transmission Quality to
Medium or High.
Be sure to reset this option to Low when you use a
modem or other slow connection.
CAUTION When you have a slow connection, using
Medium or High may cause problems with your connection.
It is recommended that you set up your environment level
every time you change the transmission quality.
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Using Manual conversation mode

U

se Voice Chat’s Manual conversation mode if you’re having problems using Voice Chat or you want
additional control over when speech is sent over the connection. Manual mode requires that you press a
button in order to talk.

In Manual mode, click the
walkie-talkie button in order
to talk.

If you are using full duplex,
you can leave the button
down and still hear the
other person. If you are
using half duplex, you
must release the button to
hear the other person.

Voice Chat has two conversation modes: Automatic and
Manual.

• Manual mode requires you to click a button in order to
talk.

• Automatic is the normal conversation mode, and allows
hands-free operation of Voice Chat. Automatic mode
sends speech whenever you talk.

In most cases, Automatic mode is recommended.
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. . . Using Manual conversation mode
Use Manual mode if you’re having problems using Automatic mode, or if your sound card does not support Automatic mode. If your work environment is very noisy, you
might have problems using Automatic mode. You can also
use Manual mode to control exactly when speech is sent to
the other person.
To change to Manual conversation mode:
1 On the Options menu, click Voice Chat Options.
2 On the Advanced tab, click Manual Mode.
3 Click OK.
The next time you use Voice Chat, the window includes a
walkie-talkie button that you use to talk.

Talking in Manual mode
Manual mode works differently depending on whether your
conversation is full duplex or half duplex.
• When using half duplex, you click the walkie-talkie button once in order to talk. While you’re talking, the other
person cannot talk to you (he or she sees a “Don’t Talk”
icon) until you click the button again to release it. The
other person can then talk.
• When using full duplex, you also click the walkie-talkie
button once in order to talk, but you don’t need to
release it to allow the other person to talk, since in full
duplex, you can both talk at the same time.
Therefore, you can just leave the button down until you
and the other person are finished talking, since the other
person can talk to you when your button is pressed.
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Troubleshooting

Introduction to troubleshooting
This chapter provides checklists for solving problems and
improving performance. These checklists are designed as a
quick overview of possible solutions, with enough information to guide experienced users to solutions.
For detailed, step-by-step information, consult the troubleshooters in online Help. The troubleshooters are designed
to solve problems you may encounter in opening connec-

tions and using the services once you have opened connections.
To use an online troubleshooter, open the Troubleshooting
book in Help Topics and display one of the topics. Then
answer the questions about your problem and try the suggested remedies. In some cases you will find shortcut buttons to dialog boxes; use these buttons to resolve the
problem faster.

Use the online troubleshooters for step-bystep solutions.
On the Contents tab of Help Topics, open
the Troubleshooting Book and display one

Try the solution that
fits your problem.
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Checklist for modem connections
Allow incoming connections by changing passwords in
your Log-in List (upgrades only)

nect to a computer running LapLink Gold or another Windows-based version of LapLink.

Passwords in LapLink Gold are case-sensitive; passwords
in versions earlier than LapLink 20001 are not. If you have
upgraded, you may have to change passwords in your Login List:

In Windows 95 and Windows 98 use your Windows modem for LapLink connections and enable its port

•

To allow incoming connections from earlier LapLink versions, retype their passwords in ALL CAPITAL LETTERS.

•

To allow incoming connections from other computers
that have upgraded to LapLink Gold, assign them new
passwords.

Enable connections to other computers by changing
passwords in your Address Book (upgrades only)
Passwords in LapLink Gold are case-sensitive; passwords
in versions earlier than LapLink 2000 are not. If you have upgraded, you may have to change passwords in your Address
Book:
•

•

If your Address Book has entries for computers running
earlier LapLink versions, retype the passwords in ALL
CAPITAL LETTERS.
If your Address Book has entries for other computers
that have upgraded, have new passwords assigned on
those computers and change your Address Book.

Run LapLink on both computers
No connections are possible by modem or any other means
unless LapLink is running on both computers. You can con1 Versions before LapLink 2000 include LapLink Pro,
LapLink Tech, and LapLink 7.5 or earlier.

In Windows 95 and Windows 98 it’s a good idea to specify
the modem you’ve already set up in Windows as the modem
to use in LapLink, too. (In Windows NT, there is no alternative to using the Windows modem.) In LapLink, click Port
Setup (Options menu), click Windows Modems, and then
check the Enable Port box.
If you have trouble communicating using the Windows modem, use Port Setup to enable the COM port to which the
modem is attached.
Ensure that the modem can answer a call
A modem cannot answer an incoming call unless the Auto
Answer option is on. In Port Setup (Options menu), click
Windows Modems. Click Configure, and then verify that Enabled under Auto Answer is checked.
Make sure the modem port is not already in use
LapLink cannot use a modem as long as the modem port is
being used by another program. Either close the program or
wait until it releases the port.
Check the settings for a Windows modem
If your modem does not answer calls or dial after you have
enabled it as a Windows modem in LapLink, exit LapLink,
and make sure the modem is turned on. In the Windows
Control Panel, double-click Modems, click the Diagnostics
tab, and click the appropriate port. Click More Info. If the test
fails, click the General tab, and remove the modem. Shut
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down the computer and then restart it. Return to Modems in
the Control Panel and reinstall the modem.
Disable error control and data compression on both
computers
Some modems communicate better if error control and data
compression are disabled on both computers. In Port Setup
(Options menu), click Windows Modems, Configure, and
then Properties. On the Connection tab, click Advanced.
Then clear Use Error Control. Repeat this procedure on the
other computer.
Set a longer timeout value
If the computer you are dialing takes a long time to answer
and complete the connection, try increasing its modem timeout. In Port Setup (Options menu), click Windows Modems.
Click Configure and then Properties. On the Connection tab,
type a larger number in this box: Cancel the Call If Not Connected Within.
Lower the modem speed on the computer opening the
connection
In Port Setup (Options menu), click Windows Modems. Click
Configure and then Properties. On the General tab, click a
lower speed in the Maximum Speed box.
Check the security setup on the remote computer
If you are denied the use of Remote Control or one of the
other services while connected to another computer, check
the security setup on that computer. You can gain access to
services through Security (Options menu).
NOTE To let other computers connect to your computer by
modem, you must change the security setup established
during installation.
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Disable call waiting
Ensure that the call waiting feature is disabled on the telephone systems at both ends of the connection. Call waiting
interferes with modem connections when incoming calls are
detected.
Try using Dialing Properties to simplify the dialing process
When you use a Windows modem, try using the Dialing
Properties feature in connection with Address Book. It simplifies the process of accessing outside lines, making longdistance and international calls, and using a calling card.
With the proliferation of area codes, however, you may find
that some numbers may not be dialed correctly, as when you
make a local call to another area code or a long-distance call
within the same area code. In this case, edit your Address
Book entry for that number so that the Use Country Code
and Area Code box is cleared. In the Telephone Number
box, type the number exactly as it is to be dialed. Include the
number for outside access, country code, area code, and “1”
for long-distance, as required. (When you travel, you may
have to edit this data to reflect your current location.)
Disable other programs that use COM ports while running LapLink
You may experience problems if you use LapLink to connect
by modem while running any other programs that monitor
serial (COM) ports; modem and fax programs typically monitor serial ports for incoming calls or faxes and may cause a
modem to disconnect unexpectedly. Disable such programs
while using LapLink.
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Checklist for Dial-Up Networking connections
Allow incoming connections by changing passwords in
your Log-in List (upgrades only)
Passwords in LapLink Gold are case-sensitive; passwords
in versions earlier than LapLink 20001 are not. If you have
upgraded, you may have to change passwords in your Login List:
•

To allow incoming connections from earlier LapLink versions, retype their passwords in ALL CAPITAL LETTERS.

•

To allow incoming connections from other computers
that have upgraded to LapLink Gold, assign them new
passwords.

those computers and change your Address Book
accordingly.
Ensure that Dial-Up Networking is installed
You can connect over Dial-Up Networking only if Microsoft
Dial-Up Networking has been installed. Dial-Up Networking
should already be installed in Windows NT. In Windows 95
or Windows 98, you can install this feature from your Windows CD-ROM as follows: In the Windows Control Panel,
double-click Add/Remove Programs. Click the Windows
Setup tab, and double-click Communications. If Dial-Up Networking is checked, it is installed. If it is not checked, click
Dial-Up Networking, and then click OK to begin installation.

Enable connections to other computers by changing
passwords in your Address Book (upgrades only)

NOTE For more information about Microsoft Dial-Up Networking, consult Windows Help.

Passwords in LapLink Gold are case-sensitive; passwords
in versions earlier than LapLink 2000* are not. If you have
upgraded, you may have to change passwords in your Address Book:

Once connected using Dial-Up Networking, connect to
the network

•

If your Address Book has entries for computers running
earlier LapLink versions, retype the passwords in ALL
CAPITAL LETTERS.

•

If your Address Book has entries for other computers
that have upgraded, have new passwords assigned on

1 Versions before LapLink 2000 include LapLink Pro,
LapLink Tech, and LapLink 7.5 or earlier.

When you connect over Dial-Up Networking in LapLink, you
dial in to a remote access server and connect to a network.
Then you make LapLink connections in the Connect over
LAN (Network) dialog box. Unless you specify otherwise, the
list of available LapLink connections appears automatically
as soon as you are connected to the network. If the list of
connections does not appear automatically, click the Connect Over button on the LinkBar and then click Network.
TIP To connect to another LapLink computer once a DialUp Networking connection is established, make sure that
this box is checked in the Connect over Dial-Up Networking
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Ensure that your computer is set up for network connections
Making connections to other LapLink computers through
Dial-Up Networking requires that your computer meet the requirements for network connections in LapLink: a network
protocol must be installed, your network ports must be enabled in LapLink, and so on. For more information about network connections, see page 135.
NOTE To let other computers connect to your computer
through Dial-Up Networking, you must change the security
setup established during installation.
Run LapLink on both computers
No connections are possible by Dial-Up Networking or any
other means unless LapLink is running on both computers.
You can connect to a computer running LapLink Gold or another Windows-based version of LapLink. Verify that the
computer has a network port enabled for the same kind of
network connection as your network port.
Try using Dialing Properties to simplify the dialing process
When you use a Windows modem, try using the Dialing
Properties feature in connection with Address Book. It simplifies the process of accessing outside lines, making longdistance and international calls, and using a calling card.
With the proliferation of area codes, however, you may find
that some numbers may not be dialed correctly, as when you
make a local call to another area code or a long-distance call
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within the same area code. In this case, edit your Address
Book entry for that number so that the Use Country Code
and Area Code box is cleared. In the Telephone Number
box, type the number exactly as it is to be dialed. Include the
number for outside access, country code, area code, and “1”
for long-distance, as required. (When you travel, you may
have to edit this data to reflect your current location.)
Disable other programs that use serial (COM) ports
while running LapLink
You may experience problems if you use LapLink to connect
by modem while running any other programs that monitor
serial (COM) ports; modem and fax programs typically monitor serial ports for incoming calls or faxes and may cause a
modem to disconnect unexpectedly. Disable such programs
while using LapLink.
Disconnect a Dial-Up Networking connection manually
When connecting by modem, you can instruct LapLink to
break a connection after a specified number of minutes in
which there is no activity at either end of the connection:
Click Connect Options (Options menu). On the Disconnect
tab, check the Disconnect Inactive Connections box, and
type the number of minutes below.
In most cases, the connection is completely broken after the
specified period. With Dial-Up Networking connections,
however, you must complete the process: click Disconnect
(Connect menu) and then click Disconnect All.

Troubleshooting

Checklist for network connections
Allow incoming connections by changing passwords in
your Log-in List (upgrades only)
Passwords in LapLink Gold are case-sensitive; passwords
in versions earlier than LapLink 20001 are not. If you have
upgraded, you may have to change passwords in your Login List:
•

To allow incoming connections from earlier LapLink versions, retype their passwords in ALL CAPITAL LETTERS.

•

To allow incoming connections from other computers
that have upgraded to LapLink Gold, assign them new
passwords.

Enable connections to other computers by changing
passwords in your Address Book (upgrades only)
Passwords in LapLink Gold are case-sensitive; passwords
in versions earlier than LapLink 2000* are not. If you have
upgraded, you may have to change passwords in your Address Book:
•

If your Address Book has entries for computers running
earlier LapLink versions, retype the passwords in ALL
CAPITAL LETTERS.

•

If your Address Book has entries for other computers
that have upgraded, have new passwords assigned on
those computers and change your Address Book
accordingly.

1 Versions before LapLink 2000 include LapLink Pro,
LapLink Tech, and LapLink 7.5 or earlier.

Enable the network port for LapLink connections
Access to a network by e-mail and other programs does not
automatically provide network access in LapLink. To connect by network in LapLink, your network port must be enabled—that is, made available for use in LapLink. To enable
a network port in LapLink, click Port Setup (Options menu).
Click the type of network—either IPX or TCP/IP—in the
Ports list. Then check the Enable Port box. If the network is
IPX, click Configure, and ensure that Internetwork Name
Broadcast is checked.
Run LapLink on both computers
No connections are possible by network or any other means
unless LapLink is running on both computers. You can connect to a computer running LapLink Gold or another Windows-based version of LapLink. Verify that the computer has
a network port enabled for the same kind of network connection as your network port.
Refresh the list of connections
If LapLink was started on the other computer after you started connecting, you may need to refresh the list of available
connections in order to include the computer in the list. Click
the Refresh List button, and wait while the list of LapLink
computers is updated.
Ensure that the network is installed
LapLink cannot connect by network unless a network protocol—either IPX or TCP/IP—is installed. Network protocols
are installed using the Networks option in the Windows Control Panel. See your Windows Help and documentation for
information on adding network protocols.
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Type the TCP/IP name or address
If you do not see a computer listed as an available connection over a TCP/IP network, you may have to type the computer’s IP name or address. Click the Connect Over button
on the LinkBar, and then click Network. On the TCP/IP Addresses tab, type the IP address or the Windows computer
name in the TCP/IP Name or Address box. (This name may
differ from the name assigned to the computer in LapLink.)
TIP To determine the TCP/IP address for a Windows 95 or
Windows 98 computer, click Port Setup (Options menu);
click TCP/IP in the Ports list; and then click Configure. The
computer’s address appears in the IP Address box.
TIP To determine the TCP/IP address for a Windows NT
computer, click the Start button, point to Programs, and click
Command Prompt. Then type IPCONFIG and press
ENTER. The address appears on the IP Address line.
TIP If you cannot connect after typing a TCP/IP address,
click the Start button, point to Programs, and click MS-DOS
Prompt. Then type PING followed by a space and the
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address you are trying to reach. Press ENTER. If you do not
receive a positive reply, the address is not available, and
you cannot connect.
Check the security setup of the remote computer
If you are denied the use of Remote Control or one of the
other services while connected to another computer, check
the security setup on that computer. You can gain access to
services through Security (Options menu).
IPX connections: change the type of frame on both
computers
Some IPX connections work better if the frame type for the
IPX connection is preset rather than selected automatically;
try setting the frame type to Ethernet 802.2 or Ethernet
802.3. This setting should be changed on both computers
making a LapLink connection. Network protocols are installed using the Networks option in the Windows Control
Panel. See Windows Help and documentation for information on changing the frame type.
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Checklist for Internet connections
The computer you want to connect to must have its Internet address published by an ILS (Internet locator service), and you must know what the address is

up (Options menu). Click TCP/IP in the Ports list and then
check the Enable Port box. Perform this operation on both
computers.

Connect over ILS is designed for connecting to a computer
whose Internet address is “published” by the LapLink ILS or
another ILS. To set up a computer for this kind of connection,
click Internet Directory Options (Options menu) and type an
e-mail address or other unique identifier to be published as
the computer’s Internet address. Let other LapLink users
connect by sharing the address with them.

Check the security setup on the remote computer

TIP Set up Internet Directory Options to have the address
published automatically. Or publish the address yourself,
when you are online: on the Connect menu, click Publish
My Internet Address.

If you are denied the use of Remote Control or any of the other services while connected to another computer, check the
security setup on that computer. You can gain access to services through Security (Options menu).
NOTE To let other computers connect to your computer by
Internet, you must change the security setup established
during installation.
Internet connections between computers on local TCP/
IP networks may require special configuration

TIP If you are connecting to a computer whose IP address
you know, use Dial-Up Networking instead of Connect over
LAN (Network). This kind of connection is usually feasible
only when you connect to a computer that has a permanent
IP address.

Without proper configuration, LapLink connections over the
Internet may be prevented if either of the computers is on a
private or corporate TCP/IP network.

Both computers must be on the Internet and running
LapLink

LapLink requires the use of two TCP/IP ports: one for the
host (the computer receiving the incoming connection) and
another for the guest (the computer opening the connection).
To facilitate LapLink connections over the Internet, LapLink
has registered port 1547 with the Internet Assigned Numbers Authority. This port is used by the host computer. To allow LapLink connections through a firewall, a network
administrator should open port 1547.

It doesn’t matter how it’s done—by dialing in to an ISP or
connecting over a direct line—but both computers must be
connected to the Internet before they can connect using
Connect over ILS.
And LapLink must be running on both of them.
Enable a TCP/IP port in LapLink
To connect over the Internet in LapLink, a TCP/IP network
port must be enabled—that is, made available for use in
LapLink. To enable a TCP/IP port in LapLink, click Port Set-

NOTE If you have any questions about your corporate
network, consult the network administrator.

With most networks, this is the only configuration required.
With other networks, however, it may be necessary to specify a port for use by the guest computer. In many cases, the
TCP/IP stack assigns guest computers the next available
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TCP port number above port 1024, and the firewall automatically allows the connection.
If the firewall does not allow automatic port assignment, however, LapLink must be configured on the guest computer to
request a specific port. Consult your network administrator
before making this change.
To request a specific port on a guest computer, add the following section to the computer’s LLW.INI file (the file is located in the \TSI32\LLW folder within the Windows folder):
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[TCPIP]
ClientPort=xxxxx
For xxxxx type any number between 1025 and 65535, except 1547. Using a large number—for example, a number
above 30000—reduces the chance of conflicts with other
TCP/IP applications.
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Checklist for cable connections
Ensure that Autoconnect is turned on
Autoconnect opens cable connections for you automatically.
To ensure that Autoconnect is in effect, click Connect Options (Options menu). On the Connect tab, verify that this
box is checked: Enable Autoconnect. Below the option, verify that the services you want to use are also checked.
TIP If you have trouble maintaining a cable connection, try
disabling Autoconnect on one or both of the computers.
Run LapLink on both computers
No connections are possible by cable or any other means
unless LapLink is running on both computers. You can connect to a computer running LapLink Gold or another Windows-based version of LapLink.
Check the cable
Make sure that each end of the cable is securely attached to
the proper port; check the port labels for proper identification.
Check a parallel cable for damaged pins. Try reconnecting
the cable to each port or even reversing the cable ends.
TIP Attach a yellow LapLink cable to parallel/LPT (printer)
ports. Attach a blue LapLink cable to serial/COM (modem or
mouse) ports; connect only one end to each computer.
LapLink does not work over most other serial cables or any
printer cables. Attach a LapLink USB cable to a USB port or
a USB hub at each computer.

Consult the Windows Device Manager when in doubt
about USB or other kinds of ports
If you are not certain whether you have a USB port or another kind of port, check the Windows Device Manager: Rightclick My Computer; then click Properties. Look on the Device
Manager tab. Note that USB connections are not available in
Windows NT or in early versions of Windows 95.
Enable the port
You cannot connect by cable until a port is enabled—that is,
made available specifically to LapLink. To enable a port for
cable connections, click Port Setup (Options menu). Click
the port you want to enable. Then check the Enable Port
box.
TIP If a port is listed as unavailable, quit any program that
may be using the port, or enable a different port. Make sure
that the cable is attached to an available port.
Use a serial cable when connecting to a Windows NT or
Windows 2000 computer
When you want to connect by cable to a computer running
LapLink in Windows NT or Windows 2000, parallel connections are not available. Use a serial cable instead.
Serial cable connections: lower the speed of a serial
port
In Port Setup (Options menu), click the COM port to which
the cable is attached. Click Configure. In the Port Speed box,
click 57600. Repeat this procedure on the other computer. If
you still can’t connect, repeat the procedure, lowering the
speed one step at a time until you can connect.
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Restart the computer

hanced driver is preferable when you alternate between parallel communications and other types of communications:
you can leave the parallel port enabled without experiencing
any degradation of performance. The Windows driver, on
the other hand, generally provides better performance for
parallel connections; use the Windows driver if you intend to
use parallel connections exclusively. If you then want to
switch to modem or some other type of communication, be
sure to disable the parallel port beforehand.

If all else fails, remove the cable from both computers, and
restart the computers. Reattach the cable, and try the connection again.

NOTE For maximum performance from an ECP port, use
the Windows driver for the parallel port to which the cable
is attached.

Serial cable connections: check for an internal modem
In Port Setup (Options menu), look for an internal modem
that is enabled for the serial port to which the cable is attached. Change the port setup so that the modem is enabled
for a different serial port.
NOTE Parallel cable connections are not available in Windows NT or Windows 2000; use a serial cable instead.

Improving parallel cable performance in Windows 95
and Windows 98
There are three drivers you can use in LapLink for parallel
ports: the LapLink Enhanced driver (the default), the LapLink
Standard driver, and a Windows driver. The LapLink En-
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To change the parallel port driver, click Port Setup (Options
menu) and then click the appropriate LPT port. Ensure that
the Enable Port box is checked. Click Configure and then
click one of these options: Use the Windows Driver, Use the
LapLink Enhanced Driver, or Use the LapLink Standard
Driver.
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Checklist for wireless connections
Make sure you’re not trying to connect to a Windows NT
or Windows 2000 computer
You cannot connect computers using wireless devices when
either or both of the computers are running Windows NT or
Windows 2000. Use a serial cable instead.
Set up the Windows infrared driver
The Windows infrared driver supports a variety of built-in
ports and devices attached to serial ports. When you set up
the driver, specify any serial port, from COM1 to COM9, as
the redirected port. In LapLink Port Setup (Options menu),
enable the redirected port for wireless communications.
NOTE In LapLink, wireless refers to short-range connections over infrared or radio devices. Other “wireless” connections are available over wireless LAN adapters (using
Connect over LAN (Network)) and cellular modems (using
Connect over Modem).
Edit the LapLink initialization file if you use AirShare Radio Modules
A setting in the LLW.INI file must be changed in order to connect computers using AirShare Radio Modules. Open
LLW.INI in Notepad; the file is located in the \TSI32\LLW
subfolder within your Windows folder. Locate the section of
the file corresponding to your wireless port: [COM1],
[COM2], and so on. Edit the section so that it includes this
line: UseIRDADriver=No.
Restart LapLink. In Port Setup (Options menu), ensure that
the port is enabled for wireless communications.

Enable the wireless port
You cannot connect by wireless until a serial port is enabled
for wireless connections in LapLink. In Port Setup (Options
menu), click the COM port to which the wireless device is attached. Click Wireless in the Type box, and then check the
Enable Port box.
Ensure that Autoconnect is turned on
Autoconnect opens wireless connections for you automatically. To ensure that Autoconnect is in effect, click Connect
Options (Options menu), and verify that this box is checked:
Enable Autoconnect. Below the option, verify that the services you want to use are also checked.
Run LapLink on both computers
No connections are possible by wireless or any other means
unless LapLink is running on both computers. You can connect to a computer running LapLink Gold or another Windows-based version of LapLink.
Check the cable, if any
If you have an external wireless device, make sure that its
cable is securely attached to the proper port.
Lower the speed of the ports
If you are using wireless devices without the Windows infrared driver, try lowering the port speeds on both computers.
In Port Setup (Options menu), click the COM port to which
the wireless device is attached. Click Configure, and then
click 57600 in the Port Speed box. Repeat this procedure on
the other computer. If you still can’t connect, repeat the procedure, lowering the speed one step at a time.
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Checklist for CAPI 2.0/ISDN connections
Allow incoming connections by changing passwords in
your Log-in List (upgrades only)

Run CAPI-compatible versions of LapLink on both computers

Passwords in LapLink Gold are case-sensitive; passwords
in versions earlier than LapLink 20001 are not. If you have
upgraded, you may have to change passwords in your Login List:

No connections are possible by CAPI 2.0/ISDN or any other
means unless LapLink is running on both computers. Ensure that the version of LapLink running on that computer is
compatible with
CAPI 2.0/ISDN.

•

•

To allow incoming connections from earlier LapLink versions, retype their passwords in ALL CAPITAL LETTERS.
To allow incoming connections from other computers
that have upgraded to LapLink Gold, assign them new
passwords.

Check the security setup on the remote computer
If you are denied the use of Remote Control or one of the
other services while connected to another computer, check
the security setup on that computer. You can gain access to
services through Security (Options menu).

Enable connections to other computers by changing
passwords in your Address Book (upgrades only)

Ensure that LapLink is set up to answer calls over CAPI
2.0/ISDN

Passwords in LapLink Gold are case-sensitive; passwords
in versions earlier than LapLink 2000* are not. If you have
upgraded, you may have to change passwords in your Address Book:

CAPI cannot answer an incoming call unless the Auto Answer option in LapLink is enabled. In Port Setup (Options
menu), click CAPI 2.0/ISDN. Click Configure, and then verify
that the Enable box under Auto Answer is checked.

•

If your Address Book has entries for computers running
earlier LapLink versions, retype the passwords in ALL
CAPITAL LETTERS.

•

If your Address Book has entries for other computers
that have upgraded, have new passwords assigned on
those computers and change your Address Book
accordingly.

1 Versions before LapLink 2000 include LapLink Pro,
LapLink Tech, and LapLink 7.5 or earlier.
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If you are using ISDN in North America, avoid using the
LapLink CAPI 2.0/ISDN
In North America, ISDN doesn’t usually include CAPI 2.0 but
you can still use your ISDN device in LapLink. If the device is
set up as a Windows (TAPI) modem, you can open a
LapLink connection using Connect over Modem or Connect
over Dial-Up Networking. Simply ensure that the device is
enabled in LapLink Port Setup (Options menu) as a Windows modem.
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If your ISDN device is set with its own dialer, use the dialer to
log on to a network. Then, in LapLink, use Connect over LAN
(Network) to connect to other computers running LapLink on
that network.

Close some LapLink services to allow connections over
both channels
Normally CAPI 2.0/ISDN hosts on which channel bonding is
not enabled can handle incoming connections on both channels. When only one connection is possible, try closing services on that connection.
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Checklist for File Transfer
Drop files directly on target folder

Make File Transfer available to other computers

The most common mistake in drag and drop is dropping files
on the wrong target folder (the folder to receive the files). To
help prevent this mistake, open the target folder first; the
name of the folder now appears in the title bar. Then open
the source folder and select and drag the files until the
mouse pointer rests on the open folder and the folder is highlighted. As soon as you release the mouse button, you receive a confirmation dialog box showing, among other
things, the target you just dropped on. Check the target, and
change it if necessary.

If you are denied the use of File Transfer or one of the other
services while connected to another computer, check the security setup on that computer. You can gain access to services through Security (Options menu).

TIP To ensure that files are copied, press CTRL while dragging. To ensure that files are moved, press SHIFT while
dragging.
TIP If you are copying an entire folder (rather than files
within a folder), drop the folder on the target one level higher
than where you want the files to appear; this may be
another folder or a drive letter. Assume that you want to
update your Letters folder on your desktop computer with
your Letters folder from your laptop, and the Letters folder
appears at the highest level of folders on drive C. Drag the
folder from the laptop to the desktop and drop it on drive letter C.
Use the Copy or Move command
Instead of using drag and drop, use the Copy or Move command. First, click the target folder. After selecting the files to
be transferred, click Copy or Move (File menu). Then verify
that the source and target are correct.
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Log on to Windows before trying to use File Transfer
As a security measure, LapLink does not allow users to connect to a computer and open File Transfer while the computer is waiting to be logged on to Windows. (When you attempt
to open a File Transfer connection to a computer running
LapLink and displaying the Windows logon dialog box, you
see this message: “Creation of window failed.”)
The solution is to open a Remote Control connection first.
Log the remote computer on to Windows and then open File
Transfer.
NOTE To set up LapLink to run before the Windows logon
dialog box appears, click Remote Control Options
(Options menu). On the Startup tab, check this box:
Always Start LapLink before Windows Logon Prompt.
General tips for faster transfers
Follow these suggestions to improve transfer speeds:
•

Check the folders and files you have selected for transfer, making sure that you are not including more than
necessary. For example, have you selected an entire
folder when you want to transfer only a few files within
the folder?

•

Use SpeedSync to improve file transfer times when
updating files, particularly over modems: on the Perfor-
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•

mance tab of File Transfer Options, make sure that the
Use SpeedSync on All File Transfers box is checked.

Maximum Speed list on the General tab, click the maximum
speed your modem can use.

Disable any ports that are not in use: in Port Setup
(Options menu), click an unused port, and then clear
the Enable Port box.

Tips for transfers over a network
•

Transfer your files when there is less traffic on the network.
Ask your system administrator to verify that the network
drivers are current.

•

Close other service windows and any connections to
other computers you may have opened in LapLink.

•

•

On laptop computers, disable power management
functions. Attach the AC adapter to the computer to
ensure steady voltage throughout the transfer.

Tips for SmartXchange

•

Disable screen savers, and close other programs.

Tips for transfers over a serial cable
•

Ensure that the serial port is configured for maximum
speed: in Port Setup (Options menu), click the appropriate COM port; click Configure; and ensure that Port
Speed is set at 115200.

•

Change the transfer mode to standard: in Port Setup
(Options menu), click the appropriate COM port; click
Configure; and click Standard under Transfer Mode.

Tips for transfers over modems
Consult the documentation for your modem and verify that
the port speed is set for optimum performance: In Port Setup
(Options menu), click Windows Modems. Click Configure,
and click the modem you are using. Click Properties. In the

Use SmartXchange to update files in two folders so that the
folders share the latest files. Since SmartXchange always
overwrites older files, do not use it if you want to merge the
contents of two files. Use SmartXchange by opening the two
folders you want to update; do not select the individual files.
After clicking SmartXchange (SyncTools menu), verify that
you have opened the right folders. If you do not want to add
new files to either folder, check this box: Transfer Only If
Files Are Already on Target.
Ensure that you have read access rights to network files
you want to copy
If you can locate the files you want to copy but then are denied access when you attempt to copy them, contact the network administrator. You can copy only files to which you
have been assigned read access.
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Checklist for Xchange Agent
Ensure that LapLink is running on the remote computer
LapLink must be running on the remote computer before an
agent can connect to it and synchronize files. On the local
computer merely keep Windows running. (LapLink will start
automatically when the agent runs.)
Make sure that a scheduler program is running
To schedule Xchange Agents—and have them run on
schedule—you must have a supported scheduler program
running.
LapLink prepares an Xchange Agent to run on either of
these scheduler programs: the System Agent program included in the Microsoft Plus! Companion for Windows 95;
and the Task Scheduler program included in Windows 98
and Microsoft Internet Explorer 4.0 (not supported in Windows NT 4.0). If you don’t have either of these programs,
LapLink uses its own scheduler program, which it installs
during Setup. (Its icon appears at the right end of the Windows taskbar.)
NOTE When LapLink Scheduler is running, its icon
appears on the Windows taskbar.
Change an Xchange Agent schedule in your scheduler
program
Once you've created an Xchange Agent schedule in
LapLink, revise or delete the schedule in your scheduler program, not in LapLink.
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You can disable LapLink Scheduler if you do not intend
to use it
If you do not intend to use LapLink Scheduler to run
Xchange Agents, you can keep it from starting automatically
every time you start Windows.
To disable LapLink Scheduler, right-click the Windows Start
button and click Open (in Windows NT, click Open All Users). Double-click Programs and then Startup. Click Scheduler and press DELETE.
Close an Xchange Agent before it is scheduled to run
An agent cannot run on schedule while it remains open in
Xchange Agent.
Create an Address Book entry to meet the security requirements of the remote computer
If the remote computer requires a name and password, create an Address Book entry and include the name and password required by that computer. LapLink can then send this
information and connect automatically.
Turn off the LapLink callback feature
If the remote computer requires or requests a callback before opening a modem connection, the agent cannot run. On
the remote computer, turn off the callback feature: Click the
Security button on the LinkBar. On the Log-in List tab, click
the name of the guest computer and then click Edit. Under
Modem Callback, click None.
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Avoid moving or deleting agent files for which you have
created shortcut icons

TIP Preview the agent to see if the correct files are included
in the synchronization.

If you have moved or deleted the Xchange Agent file, the
shortcut icon can no longer run the agent. Create the agent
again. You can reuse the shortcut icon by saving the new file
in the same location, with the same name, as the original file.
Or you can create a shortcut icon for the new agent file.

Use Preview to limit the files to be copied in the current
synchronization

Create a filter to synchronize a single file
Xchange Agent always synchronizes by folder pairs, but you
can create a filter so that only one file within a folder pair is
synchronized. Open the agent in Xchange Agent and click
the folder pair. On the Edit menu, click Set Filter and then
click New. After typing a description for the filter, type the
complete name of the file, including its extension. (To add
more than one file name, type a semicolon and then the next
file name.) Click OK. Click the filter’s name in the Available
Filters list, and then click Add.

While previewing an agent, you can specify that certain pairs
of files and folders will be omitted from the current synchronization: Click a pair of files or folders and then click the Skip
Pair button on the toolbar. Repeat this procedure for any other pairs you do not want synchronized. Then—before closing Preview or quitting Xchange Agent—run the agent.
TIP You can omit file and folder pairs only from the current
synchronization. To remove them from a future synchronization, you must use Preview again.
Use Xchange Agent to overwrite, not merge, files
Xchange Agent overwrites files. Unless you specify otherwise, it copies the newer file to the other computer. It does
not merge files. To merge databases and other shared files,
use the program in which the files were created.
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Checklist for Remote Control
Improve performance from the guest
On the guest, you may be able to speed up Remote Control
connections by changing settings in Remote Control Options (Options menu) on your computer. On the Performance tab, click the Best Performance option. (To further
customize settings, click the Settings button.) Your view of
the host should be updated faster, though you will now be
viewing the host screen in black and white, and larger bitmaps will not be displayed.
Control the display properties of the host from the guest
By default, LapLink is configured to speed up Remote Control connections: any wallpaper or screen saver on the host
is temporarily disabled, along with certain other visual enhancements. From the guest, you can restore these enhancements to the host screen through settings on your
computer. On the Performance tab of Remote Control Options (Options menu), click Best Quality. (To further customize settings, click the Settings button.) Keep in mind that
changing these settings may slow Remote Control connections.
Make Remote Control available to other computers
If you are denied the use of Remote Control or one of the
other services while connected to another computer, check
the security setup on that computer. You can gain access to
services through Security (Options menu).
Use the keyboard to view the host screen
If the window in which you are viewing the host screen does
not show all of the host screen, you can use your keyboard
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to view areas beyond the borders of the window: press
CTRL+ALT+SHIFT and any of the arrow keys, PAGE UP,
PAGE DOWN, HOME, or END.
Use the latest driver for your video adapter
Contact the manufacturer of your video adapter, on its Web
site or elsewhere, to verify that you are using the latest driver.
Avoid changing the color depth or display properties of
a host
From the guest, avoid changing the number of colors displayed on the host while you're connected to it using Remote
Control. Also avoid changing the Refresh Frequency and
other settings in the host's Display Properties while connected. To safely change these properties, you should be seated
at the host and fully informed of the capabilities of its monitor.
Incorrect settings can damage a monitor.
Use a special key combination to log on to a Windows
NT host
When you restart a Windows NT host, you must press
CTRL+ALT+DELETE to log on to Windows again. You can
accomplish this from the guest by pressing a special key
combination specified on the host. (Pressing
CTRL+ALT+DELETE on the guest affects the guest, not the
host.) To specify a key combination for use on the guest,
start LapLink on the host and click Remote Control Options
(Options menu). On the Host tab, type the key combination
in this box: Send CTRL+ALT+DELETE to This Computer
When a Guest Presses This Key Combination.
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TIP Instead of pressing a special key combination for
CTRL+ALT+DELETE, you can click the Remote Control
icon at the bottom of the host’s LapLink workplace, and then
click Feed CTRL+ALT+DELETE.
Do not install other remote control products and
LapLink on the same computer
Because of possible incompatibilities, avoid installing
LapLink and another remote control product on the same
computer.
Avoid pressing CTRL+ALT+DELETE when viewing a
Windows NT host in full-screen Remote Control
Pressing CTRL+ALT+DELETE on a Windows NT computer
always displays the Windows Security dialog box on that
computer. When you are working in a full-screen Remote
Control session, pressing CTRL+ALT+DELETE not only
displays the Security dialog box locally but also causes the
CTRL and ALT keys to be pressed—but not released—on
the host computer. To release these keys and resume normal keyboard operation press CTRL and ALT again.
TIP To have CTRL+ALT+DELETE take effect on a host
computer, click Send CTRL+ALT+DELETE to Host on the
guest's Session menu.

Keep LapLink running before the Windows NT logon
prompt
If you have set up LapLink on the host computer to run before the Windows NT logon dialog box appears, avoid closing LapLink on that computer unless you have administrator
rights. If you close LapLink, you will have to restart the computer in order to reset LapLink so that other people can connect. (Restarting LapLink is not sufficient.)
Avoid running a Windows NT host in VGA mode
When a Windows NT computer is running in VGA mode you
can make LapLink connections from it to other computers
using Remote Control and File Transfer, but the computer
cannot serve as a Remote Control host. That is, it cannot be
remotely controlled by other computers.
Run DOS in a window on a Windows NT host
You cannot control full-screen DOS programs on a Windows
NT host. When you attempt to do so, LapLink minimizes the
program and displays a warning message. (To close the
DOS program, right-click the icon, and click Close.)
Avoid this problem by setting up the Windows NT host to display DOS programs in a window. If you use a shortcut to a
DOS program, for example, right-click the shortcut icon, click
Properties, and then click the Options tab. Below Display
Options, check Window.
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Checklist for Print Redirection
Use the same printer driver on both ends of a connection
For best print results in Print Redirection, both computers
should be set up with the same printer driver. To add a printer driver, you may need your Windows CD or a disk from the
printer manufacturer.
Use the Windows Control Panel to get additional information
If the document you printed is sent over LapLink correctly but
does not print, examine the printer in the Windows Control
Panel to get additional information about why the document
didn’t print. Make sure the printer is connected correctly and
has enough paper, and the printer cartridge is not empty.
When several printers are available, you can set up
LapLink to prompt you for the printer to use
Normally, LapLink automatically directs print jobs to the printer currently set up as the default printer at the other end of
the connection. When there are several printers available,
however, you may want to use a printer other than the default.
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To set up LapLink to allow you to choose among the available printers, click Print Redirection Options (Options menu)
on the computer the printers are attached to. Then click
Prompt with a List of Available Printers.
When printing from 16-bit programs, use the default
printer
Before printing from 16-bit Windows programs (programs
written for versions of Windows prior to Windows 95, Windows 98, and Windows NT 4.0), set up the destination printer as the default printer on the computer to which it is
attached. When using Print Redirection from the 16-bit Windows program, print to the default printer instead of selecting
a printer from the list of available ones.
Some printer drivers do not support Print Redirection
To use Print Redirection you must set up a printer to direct
print jobs to a special port instead of the usual parallel port.
You cannot use a printer driver that does not allow you to
change the port in this way. You may want to contact the
printer manufacturer to see if an updated driver is available.
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Checklist for Text Chat
Press ENTER to send your message
Type your message in the lower part of the Text Chat window. (In some cases, you may have to click in the lower part
of the window before you can begin typing.) To send your
message to the remote computer, press ENTER.
TIP To begin a new paragraph, press CTRL+ENTER.
Open a Text Chat window after connecting

fore this limit is reached. To save a conversation, click in the
upper part of the Text Chat window. Click Select All (Edit
menu), and then click Copy (Edit menu). You can then
switch to another Windows program such as Notepad, paste
the text, and save it as a file.
Shorten connection time by preparing messages beforehand

If you are connected to more than one computer, be sure to
specify which computer you want to use Text Chat with:
Click the name of the computer on the Window menu. Then
click the Open Text Chat button on the Shortcut bar or Open
Text Chat on the Window menu.

Instead of typing text while connected, you can prepare it
ahead of time in Notepad or a similar Windows program and
send it to a remote computer through Text Chat. In the other
application, select the text, and press CTRL+C to copy. In
the lower part of the Text Chat window, press CTRL+V to
paste. Then press ENTER to send.

Make Text Chat available to other computers

Use File Transfer for long messages

If you are denied the use of Text Chat or one of the other services while connected to another computer, check the security setup on that computer. You can gain access to services
through Security (Options menu).

Text Chat can send as many as 2,048 characters at once.
When you attempt to send a message that exceeds that limit, part of the message will not be transmitted to the other
computer. Try sending the message in parts. Or save the
message as a file, and send the file using File Transfer. You
can still use the Text Chat window to let the remote user
know what you’re sending and to pass along additional
notes.

Save your Text Chat conversation from time to time
As a Text Chat conversation grows in length, the most recent
messages begin to replace the earliest. This starts to happen when the conversation exceeds 32,000 characters. If
you intend to save a lengthy conversation, begin saving be-
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Checklist for Voice Chat
Use full duplex sound card drivers on both ends of the
connection

then adjust the microphone level using the Levels tab (Voice
Chat Options).

Voice Chat is easiest to use over a full duplex connection;
you can hear and be heard at the same time, as on the telephone.

Adjust your speakers or headphones to a comfortable
level

For full duplex, both ends of the connection must have sound
cards with drivers that support full duplex. Contact your
sound card manufacturer to determine whether your sound
card supports full duplex; and find out whether drivers are
available.
When using half duplex, wait for the other person to finish talking
A common problem in half duplex conversations is knowing
when to start talking. Use the stoplight icon in LapLink as a
guideline for when you can talk and when you can’t. In some
cases, a verbal signal that you are finished speaking (saying
“over,” for instance) might be helpful, or it might help to simply pause a few seconds when you are done speaking.
If you’re using Manual mode, be sure to release the walkietalkie button; you might not be able to hear the other person
otherwise.
Adjust your microphone to a comfortable level
Many microphones require adjustment in order to send clear
speech. Make sure your microphone is placed at a good distance from your mouth—not too far and not too close—and
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Most speakers, and some headphones, have a manual control that you can use to adjust volume. It is recommended
that you leave the manual controls at a medium level, and
adjust the volume of speakers and headphones in LapLink
(or in Windows).
Minimize background noise, if possible
Try moving your microphone away from telephones, loud
computer power supplies, radios, and so on. Move your
speaker and microphones farther apart.
If the person you’re talking to hears a lot of noise in your
background or doesn’t hear your voice, you might want to reset your environment level using the Levels tab (Voice Chat
Options).
Tips for improving Voice Chat performance
Perform the tests on the Levels tab (Voice Chat Options) to
get the best performance. Adjust transmission quality to
match the conditions of the connection: On the Advanced
tab of Voice Chat Options (Options menu) click Low if you
are talking over a modem or other slow connection. Click
High if you are talking over a network or other fast connection.
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Computer names on network, filtering 31
Connections
automating 42
CAPI 2.0/ISDN 38–41
Dial-Up Networking 18
firewall 28
Internet 24
modem 16
network 30–33
parallel cable 34
restoring automatically 42
saving 42
serial cable 34
USB Network cable 34
wireless 36
Controlling a host computer 60
Copying
in File Transfer 82
in Remote Control 72
in Text Chat 121
Copying files
already on target 84
existing files only 84
including subfolders 84
newer files only 84
using drag and drop 76, 82
using menu command 82
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Creating
desktop shortcuts for Xchange Agents 104
Xchange Agents 96–99
CryptoAPI encryption 56
Cutting in Remote Control 72

D
Deleting files permanently 85
Deselecting files 81
Details, viewing file and folder 78
Dialing properties 16, 20, 132
Dial-Up Networking connections
and ISDN 142
LapLink connections, opening 133
overview of 16
troubleshooting 133, 134
Disabling
automatic connections 35, 36
clipboard sharing 72
keyboard 66
mouse 66
Drag and drop 76, 82
tips 83, 144
Drives
cloning 88
copying 82
denying access to 48
expanding 78
opening 78
selecting 78
viewing contents of 78
Dropping files on target 82
Duplicating folders 88
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E
Enabling
clipboard sharing 72
File Transfer Recovery 92
modem port 131
network port 135
parallel port 139
rebooting 68
serial port 139
USB port 139
wireless port 36, 141
Encrypting data 56
CryptoAPI encryption 57
LapLink-compatible encryption 57
Existing files only, copying 84
Expanding drives and folders 78

F
Feeding CTRL+ALT+DELETE to the host 68
File names, long 103, 145
File Transfer
copying files 82
drag and drop 76, 82
moving files 82
navigating in window 78
opening 76
optimizing 90
permitting through security setup 46
resuming after an interruption 92
selecting items 76, 80
with SpeedSync 90
tips 144, 145
troubleshooting 144, 145

File Transfer Recovery 92
Files
compressing 90
copying and moving 76, 82–83
deleting to Recycle Bin 85
finding 78
merging 90
selecting 76, 80
sorting 78
synchronizing 86, 96–97
updating older copies 84
viewing the number and size of 80
Filtering
computer names on network 31
files and folders 78
files in Xchange Agent 106, 147
Finding folders and files 78
Firewall 28
Folders
cloning 88
copying 82
defined 76
denying access to 48
expanding 78
finding 78
moving 82
opening 78
replacing one with another 88
selecting 76, 80
sorting 78
synchronizing 86, 96–97
updating 86
Fonts, changing appearance in Remote Control 73
Full duplex 123, 152
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Full screen mode 62

G
Guest computer
blanking host screen from 66
changing appearance of host screen from 73
defined 60
locking host keyboard from 66
locking host mouse from 66
opening Remote Control window on 60
viewing host computer on 62

H
Half duplex 123, 152
Help for troubleshooting 130
Host computer
defined 60
locking 66
logging on to 68
preparing 68–71
rebooting 68
viewing 62
Host screen
blanking 66
changing appearance of 74
changing guest view of 62, 73
scaling image to fit 63
temporarily lowering resolution of 63
viewing full screen 62
Hosting a Remote Control session 70

I
Icons
arranging 78
on host computer 70
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Including subfolders in transfers 84
Infrared connections. See Wireless connections
Integrated System Digital Network. See ISDN
Internet addresses, publishing 26
Internet connections
behind a firewall 28
enabling host for 26
encrypting data over 56
opening 24
overview of 24
troubleshooting 137, 138
Internet directories 24
Introduction to LapLink 6–10
IP name or address 30, 136
ISDN
connecting over 38–41
troubleshooting 142, 143
See also CAPI 2.0/ISDN connections
Items, selecting 76, 80

K
Keyboard
control, customizing 64
disabling on host 66
Keys, system and shortcut 64

L
LapLink
overview 6–10
starting before Windows logon 69
LapLink Everywhere 14, 22, 23
connections from Internet browsers 23
LapLink-to-LapLink connections 23
security for 23

Index
ways of connecting 22
LapLink Internet directory 24
!LAPLINK.TSI file 93
LapLink-compatible encryption 57
Levels in Voice Chat 124
Linking clipboards 72
.LLC extension 43
LLW.INI file 141
.LLX extension 99
Local security password 54
Locking host computer 66
Lockout 50
Log-in List
adding entries to 46
enforcing 46
Log-in name 46
Long file names 103, 145
Lowercase letters in passwords. See Passwords

M
Manual mode in Voice Chat 126
Merging files 86, 90
Messages in Text Chat 120
Microphone, configuring for Voice Chat 124
Minimizing guest computer 70
Minus signs in folder icons 78
Modem connections
Address Book entries for 20
dialing from Address Book entries 16
dialing manually 21
Dial-Up Networking connections 16
LapLink-to-LapLink connections 16
opening 16
overview of 16

tips 145
troubleshooting 131–132
types of 16
Mouse
disabling on host 66
using in drag and drop 76, 82
Moving files. See Copying files

N
Navigating in File Transfer windows 78
Network connections
filtering list of available computers 31
and ISDN 142
opening 30
overview of 30
troubleshooting 135, 136
See also CAPI 2.0/ISDN connections

O
One-way file exchange 86
Opening
File Transfer 76
Remote Control 60
Text Chat 120
Voice Chat 122
Xchange Agents 100
Optimizing transfers with SpeedSync 90
Overview of LapLink 6–10

P
Passwords
case-sensitivity 21, 33, 47
from earlier versions 21, 33, 47
entering to gain access 21, 33, 47
for incoming connections 46
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Index
protecting against crackers 50
for security system 54
tips 51
troubleshooting 131, 133, 135, 142
Pasting
in Remote Control 72
in Text Chat 120
Plus signs in folder icons 78
Ports
CAPI 2.0/ISDN 142
enabling 131, 135, 139, 141
modem 131
network 135
parallel 139
serial 139
speed, changing 140
USB 139
wireless 141
Previewing an Xchange Agent 96, 147
Print Redirection
opening 114
overview of 112
requirements for 113
setting up printers for 116
troubleshooting 150
Privileges, granting to remote users 46
Protected system 46
Protecting
drives and folders 48
security options 54
Publishing Internet addresses 26

R
Rebooting host in Remote Control 68
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configuring host for 68
after guest disconnects 68
Recycle Bin, deleting to 85
Remote access servers 16
Remote Control
bitmaps displayed in 74
clipboard information, sharing 72
colors displayed in 74
controlling the host 60
fonts displayed in 73
improving performance of 73
locking the host computer 66
logging on to Windows NT during 69
minimized window on host 70
opening 60
overview of 60
permitting through security setup 46
rebooting host computer 68
requesting through Address Book 66
reversing 70
serving as a host 70
shortcut keys, changing 64
troubleshooting 148, 149
using Print Redirection in 112
using Windows system keys 64
viewing the host computer 62, 73, 148, 149
Replacing folders 88
Resolution of host screen, changing from guest 63
Restarting host in Remote Control 68
Restoring
connections 43
Text Chat automatically 120
Restricting access to a computer 46
Resuming an interrupted file transfer 92

Index
Reversing Remote Control 70
Running Xchange Agents 101

S
Saving connections 42
Scaling Remote Control windows 64
Scheduling Xchange Agents 108
Screen blanking 66
Screen saver, allowing to run on host screen 74
Security
for drives 48
encrypting data 56
for folders 48
locking out password crackers 50
Log-in List, adding entries 46
password for the security system 54
password protection, setting up 46, 54
See also Passwords
Selected files, viewing the number and size of 80
Selecting files and folders 76, 80
clearing selections 81
Selecting text in Text Chat window 121
Sending CTRL+ALT+DELETE to the host 68
Serial ports
enabling 139
speed, changing 140
Services
allowing 46
File Transfer 76
Print Redirection 112
Remote Control 60
Text Chat 120
Voice Chat 122
Setting filters in Xchange Agent 106, 147

Sharing clipboards 72
Shortcut icon
creating 42, 104
opening connections with 42
running an Xchange Agent with 101, 147
Shortcut keys in Remote Control 64
SmartXchange
tips 145
using 86
Sorting files and folders 78
Sound card, configuring for Voice Chat 123
Source
in drag and drop 76, 82
using menu commands 82–83
Speaker, configuring for Voice Chat 125
SpeedSync 90
and File Transfer Recovery 92
reviewing effect of 90
Starting
File Transfer 76
LapLink before Windows 69
Remote Control 60
Text Chat 120
Voice Chat 122
Xchange Agents 100
Statistics for SpeedSync 90
Subfolders
defined 76
including in transfers 84
navigating through 78
Synchronizing folders 86
System keys 64
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T
Talking using Voice Chat 123
Target
in drag and drop 76, 82
using menu commands 82
TCP/IP connections
IP name or address, finding 30
IP name or address, specifying 30
opening 30
troubleshooting 135, 136
Text Chat
copying text in 121
opening 120
overview of 120
pasting text in 120
permitting through security setup 46
selecting text in 121
sending messages over 120
troubleshooting 151
Tiling windows 121
Transferring files. See Copying files
Transmission Quality, improving 125
Troubleshooting
cable connections 139, 140
CAPI 2.0/ISDN connections 142, 143
Dial-Up Networking connections 133, 134
File Transfer 144, 145
Internet connections 137, 138
ISDN connections 142, 143
modem connections 131–132
network connections 135, 136
Print Redirection 150
Remote Control 148, 149
160

TCP/IP connections 135, 136
Text Chat 151
USB connections 139
using online Help for 130
Voice Chat 152
wireless connections 141
Xchange Agent 146, 147
Two-way file exchange 86

U
United States, using CAPI 2.0/ISDN in 38
USB ports
enabling 139
verifying in Windows 139

V
Viewing
files and folders 78
host computers 62
number and size of selected files 80
Voice Chat
Automatic mode 126
over a fast connection 125
full duplex 123
half duplex 123
improving quality of 125, 152
Manual mode 126
opening 122
overview of 122
performance of 124
starting 122
talking over 123
troubleshooting 152
using 122

Index

W
Wallpaper, showing on host screen 74
Window
File Transfer 76
Remote Control 60
Text Chat 120
Windows NT, logging on to during Remote Control
69
Windows system keys 64
Wireless connections
devices supported 36
enabling after installation 141
enabling security for 54
opening 36
overview of 36
troubleshooting 141
Wireless LAN adapter, connecting over 36

X
Xchange Agent 96, 97, 98, 99, 100, 101, 102, 103,

104, 105, 106, 107, 108, 109
adding folder pairs to an agent 98, 104
closing preview 100
conflicts defined 102
copying in one direction 104
creating an agent 96–99
disabling callbacks for 146
excluding files by type or name 106
filtering files 106
including files by type or name 106
overview 96
previewing an agent 96–97, 100, 146
resolving conflicts 100–103
running an agent 101
running unattended 108
running without preview 108
scheduling to run unattended 108, 146
skipping folder pairs 100
troubleshooting 146, 147
Xchange Agent wizard 98
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